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Welcome

Roland Waddilove
Mac expert Roland has been using macOS 

Sierra since the original public beta. So there’s 

no one better to go through the brilliant new 

features like Optimised Storage on page 60.

Stephen Ashby
Stephen started working on iCreate just as the 

iPhone 4 came out. Six years later and he’s still 

going strong. Turn to page 14 to check out his 

must-read iPhone 7 Power Tips feature.

Freddie Harrison
Every OS upgrade comes with some teething 

problems, so we set ex-iCreate staffer Freddie 

to hunt down readers’ issues and provide 

detailed fixes. Check them out on page 76.

Meet the experts

“77 Power Tips for iPhone 7 will help you 

make the step up to expert level”
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So you’ve got your iPhone 7 and you’ve immediately 

fallen in love with it. No surprise there – we think iPhone 

7 is Apple’s best ever. But what now? This issue’s 77 

Power Tips for iPhone 7 cover feature will help you 

make the step up to expert level. We’ll do this by 

showing you how to master your new hardware, 

including that amazing camera, detail the apps you 

need right now and showcase must-have gear to 

create the ultimate iPhone 7 experience.

Apple Watch Series 2 is out now too, and we’ve 

put the new models through their paces. Is this 

finally the smartwatch to crack the wearable 

market? Read on to find out. We’ve also compiled 

an essential guide to watchOS 3 to help you master 

every new Apple Watch feature. There’s some great 

tips and tricks in there not to be missed.

There’s over 20 pages of brand-new iOS 10 and 

macOS tutorials too, and this issue’s special Genius 

Bar will fix all your upgrade problems. Enjoy!  

Philip Morris Editor
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#Trending

The iPhone rocks the mobile world every single year. Are we in for a special treat next year?

What will Apple’s 
10th anniversary 
iPhone look like?

space the tenth anniversary iPhone could

potentially be smaller, and there is logic in the

presumption that an iPhone SE-sized device

could be made with an iPhone 6-sized screen

on-board. This would cater for those who like to

carry their phones in a pocket, and we could then

see a larger phone with a screen that is

exponentially better than what we have seen.

So, the front of the next iPhone could offer

more than we ever hoped for, but what about

the shape and size? This is difficult to gauge

and much of the assumptions are reliant upon

how well Apple is doing with improving battery

performance in a small space. The historic

obsession with making iPhones thinner seems to

be lessening somewhat and so it is quite possible

that a squarer form, like the iPhone SE, could be

brought back to house a battery large enough

to cope with the new edge-to-edge screen. This

is also a design that many feel looks better and

works in a more practical way than the curved

edges present in the iPhone 6 and 7. We can

also expect evolutions of the camera, processor

and materials used, but just maybe Apple will

decide to take a leap and hit us with a completely

Only a handful of people on the 

planet know what the tenth 

anniversary iPhone will look like, 

and because of Apple’s 

legendary secrecy it is likely to 

remain that way for most of the next year. There 

are, however, some clues in recent iPhone 

iterations that can lead us to make educated 

guesses as to what to expect. We are not going 

to play it safe and will instead presume that Apple 

will push the boundaries of what is technically 

feasible. This starts by looking at the fingerprint 

sensor and Apple’s expertise with screens; it 

seems perfectly possible that the next iPhone 

could use the entire screen as a fingerprint 

sensor, and conversely we may also see the 

removal of the physical Home button, which could 

be replaced by a virtual one that only appears 

when needed. If we take this premise further, the 

screen could potentially fill the entire front side of 

the phone. As speaker and antenna technology 

improve, it makes sense that the speaker at the 

top and the sensors could be moved to the edge, 

with maybe a tiny slither of hardware to allow for 

the front-facing camera. With this increased use of

new design that looks and feels like nothing 

before it. In a world where most phones look very 

similar no matter what operating system they use, 

it would be brilliant for Apple to make our mouths 

open in awe at a new, revolutionary design.

It is also conceivable that the iPhone will 

become buttonless. The recent removal of the 

headphone jack is a sign of intention, and if the 

Home button became virtual and the volume 

and power buttons were removed, a fully 

waterproof and dust-resistant phone is a genuine 

expectation. The improvements in iOS recently 

also lead us to believe that more advanced 

gestures could become part of the system, and 

this may include turning the phone on and off, 

changing the volume and even muting the entire 

device. We can already do a lot from the lock 

screen in iOS 10, so it makes sense to follow the 

curve and potentially see it replace buttons for 

many of your iPhone interactions, and can you 

imagine how sleek the phone would look with 

an edge-to-edge screen and no buttons? The 

iPhone already does a brilliant job of making what 

is on the screen feel like the entire experience, 

and when all other physical components are

5 landmark iPhones The iPhone continues to grow in stature from year to year

iPhone (1st 
generation)
The original iPhone took 

the traditional smartphone 

design and turned it on 

its head. With a huge 

screen (at the time) and 

software that felt like 

magic, it quickly defined 

every phone that has been 

released ever since.

iPhone 3GS
The 3GS added extra 

processing power to 

the efficiency of the 

operating system and 

with 3G support now 

expected in any new 

phone, the iPhone 

started to feel as if it 

could be used for work 

as well as play. 

iPhone 4s
Siri first arrived in the 

iPhone 4s and with 

a Retina screen and 

wonderfully crisp 

design that debuted 

in the iPhone 4 a 

year earlier, it felt as 

though Apple was 

pulling ahead of the 

rest with ease.
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Next year will mark the tenth anniversary  
of Steve Jobs’ unveiling of the original iPhone

“If the volume and power buttons
were removed, a fully waterproof
phone is a genuine expectation”
removed, we will be one step closer to holding

just a screen that happens to have an incredibly

powerful and slim computer behind it. As we said

at the start, we cannot know what will come in

2017, but it does feel as if Apple has been working

to a plan. It feels as if there is an end goal in the

improvements we have seen each year, and it is

quite possible that the culmination of all this work

could arrive in the tenth anniversary iPhone. Our

fingers are crossed!

iPhone 7

Apple proved that it 

understood its users 

by offering DSLR-like 

photography capabilities 

in the iPhone 7 Plus, 

improved battery life and 

even more memory. It’s 

the best iPhone yet and 

genuinely does feel like a 

hard act to follow.

iPhone 6/6 Plus

A huge worldwide hit, 

the iPhone 6 models 

proved that demand  

for a larger screen and 

even more power was 

far from a myth. It is 

likely that this phone  

will influence iPhone 

design for some years 

to come.

© Blake Patterson
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#Trending

Things we 
learned this 

month

While the original Apple Watch

caught the eye of millions of buyers

around the world, many held off to

see what the second version had in

store. Renowned teardown specialist, iFixit, has

wasted no time in getting to the bottom of

the hardware changes within the

Apple Watch Series 2. At the

forefront is a new, high-capacity

battery. The 273mAh battery

dwarfs the previous 205mAh

capacity found in the original Apple

Watch, even though it’s said to hold

the same 18-hour battery life.

Also found by iFixit was the addition of a

second microphone. It’s touted as being

used to help improve Siri usage on the Watch

itself, a minor problem that some users found

on the first-gen watch. The final change was

the inclusion of the GPS, which has led to both

the Taptic Engine and built-in antenna being

remodelled to fit into the Watch’s tiny frame.

Apple Pay on
Safari goes live Apple Pay

Apple Pay is finally making the move 

from your mobile to the web. Over 

the next few weeks, an assortment 

of online retailers will be integrating a ‘Checkout 

with Apple Pay’ option into their sites, which will 

allow for users to confirm payments on their iOS 10 

device. Availability of Apple Pay on Safari will be fairly 

limited at first, with the likes of Shopify and Stripe 

being some of the first to get involved. Expect bigger 

and more mainstream sites to do the same in the 

coming months.

Watch Series 2 
teardown uncovers 
hardware changes
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Google brings Cardboard
VR to iOS Google Cardboard

Google has made available its popular

Cardboard Camera app on the App

Store for iOS users. It enables users to

capture full 360-degree pictures and

enjoy them using a VR viewer and their iPhone.

Google has also introduced some new features,

most notably the addition of a new sharing platform.

There are plans for Google to integrate the iPhone

7’s 3D Touch feature into the Cardboard Camera

app, but at the time of writing, it’s not yet known

how or when it’ll be implemented.

Apple launches iMessage
App Store add-on App Store

Apple has introduced the iMessage App 

Store, a dedicated section for users to 

download apps, stickers and games to 

improve their texting experience. Many of 

the apps currently available in this new storefront are 

standalone iMessages apps, while others offer 

extensions to current apps currently available in the 

main App Store. Sticker packs also work in a similar 

way, with some as standalone packs and others as 

extensions. Simply tap on the Apps button within 

iMessage and select the Store option for access.

iPhone 7 Plus
outselling iPhone 7 iPhone

According to a recent nationwide survey

in the US, the iPhone 7 Plus is outselling

the 4.7-inch iPhone 7. It’s actually the

first time since the incarnation of Apple’s

standard and Plus ranges that the larger variant is

outselling its smaller counterpart. Slice Intelligence

found in an analysis of 32,000 pre-orders, 55 per

cent of users decided to purchase the iPhone 7

Plus. Less surprising is the news that almost 46 per

cent opted for the Black coating compared to 23 per

cent for the sleek, but scratch-friendly, Jet Black.

“55 per cent of users 
decided to purchase the 

iPhone 7 Plus”

iFixit has gone inside the new 
Apple Watch to see where the 

improvements have been made

If you would like more help with upgrading your Mac, visit the 
gadget surgeons at iFixit.com, who kindly contributed these photos.
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1 CarPlay needed
For this feature to work, your iPhone

needs to be connected to your car’s

Bluetooth or CarPlay stereo. From your

iOS home screen, tap on Settings.

1 General menu
Unlock your iPhone and go the Settings 

app. It makes sense for it to be on your 

main home screen. Scroll to the General 

menu and tap on it.

1 System Preferences
Go to the Apple menu and select 

System Preferences. The menu is largely

unchanged, apart from a brand-new Siri 

icon in the fourth row.

2 Maps menu
All of Apple’s own apps have their own 

Settings menu. Scroll down until you 

find Maps and then tap on it to see your 

options in the right-hand panel.

2 Accessibility settings
From the General menu, go to 

Accessibility. Navigate way down the 

page until you find the Home Button 

option. Select it with a single tap.

2 View your options
Click the Siri icon and you’ll be presented

with a list of different settings that can 

be tweaked, like changing the Siri Voice 

if you want.

3 Your Car
Under the Your Car sub-heading is the

Show Parked Location option. Make sure

this is enabled and you’ll never accidently

lose your car again.

3 Turn to green
Now make sure Rest Finger to Open is 

enabled, so flick the switch to green. 

Now you can use Touch ID without 

pressing the Home button.

3 Keyboard Shortcut
Our favourite setting to tweak is the 

Keyboard Shortcut option. From the 

drop-down, select Customise and create 

your own personal shortcut.

Maps received a

big update in iOS

10, but you still 

need a trip to Settings to get 

all the new features working. 

Here we illustrate where you 

need to go to enable Maps 

to show you where your 

beloved car is parked.

Siri is macOS

Sierra’s great big

advancement, 

giving Mac users a taste of 

the digital assistant life that 

iOS users have enjoyed over 

the years – and you can head 

to System Preferences to 

customise it too. 

2  Show your 
parked car location

3  Discover Siri’s 
hidden settings

Don’t like the new

Press Home to Open

button in iOS 10 and 

long for the simpler iOS 9 life? 

You can go back to resting 

your finger on the Home button 

to activate Touch ID and 

unlock your iPhone with a 

quick visit to your Settings. 

1  Get the iOS 9 
Home button

With every new operating system update comes a wealth of new secret

settings. Either housed in your iPhone or iPad’s Settings app or your

Mac’s System Preferences, these settings and menu options let you 

create a truly personal experience with a few taps or clicks. Don’t like 

the way something is done? There’s probably a setting or feature you 

can enable or disable accordingly. We’ve delved deep into the new 

operating systems to show you some prime examples. 

MINUTE PROJECTS

TO TRY TODAY

3

1 2
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Blow your clients away with URSA Mini 4.6K, the only camera that lets 

you shoot with the true digital fi lm quality of a high end Hollywood feature 

fi lm! You get a handheld, Super 35 digital fi lm camera that works with your 

existing Canon DSLR lenses, has a 4.6K image sensor with 15 stops of 

dynamic range. URSA Mini 4.6K records video as camera RAW and ProRes 

so you can edit, color correct and deliver results that are far superior and 

look better than anything you can shoot on a DSLR!

Dramatically better than DSLR Video
URSA Mini features a custom 4.6K digital fi lm sensor that shoots up to 

60 frames per second with 15 stops of super wide dynamic range! That 

means your images will retain shadow and highlight detail simultaneously 

without clipping. You’ll get clarity and textures that are impossible to 

capture with a DSLR or regular video cameras! Imagine shooting indoors 

with the correct exposure and still seeing every detail through the 

windows outside!

Lightweight and Portable
URSA Mini’s perfectly balanced body is rugged, yet lightweight and 

comfortable for all day shooting. There’s even an optional shoulder mount 

kit that lets you move from tripod to handheld in seconds! Everything you 

need is built in, so you don’t have to carry around extra equipment. You 

get a super bright 5” fold out touch screen for monitoring video, displaying 

timecode, histograms, audio meters, focus peaking and more!

Record in RAW, ProRes and more
You never have to stop recording because URSA Mini features two CFast 

2.0 recorders! When one card is full, recording continues on the next so 

you’ll never miss an important moment! Unlike DSLRs that heavily 

compress video, URSA Mini records 12-bit RAW fi les that preserve all the 

dynamic range and quality captured by the sensor. You can also record 

ProRes fi les that are easy to edit and use less storage!

Includes DaVinci Resolve
URSA Mini includes DaVinci Resolve 12.5 Studio, the same professional 

software used to edit and color correct Hollywood feature fi lms, television 

shows and commercials! With DaVinci Resolve 12.5 Studio you get the 

world’s best professional editor and color corrector, along with incredible 

new e� ects so you can edit, color correct, add e� ects and deliver projects 

from start to fi nish, all in one single software tool!

URSA Mini lets you shoot true digital fi lm quality 
that’s dramatically better than a DSLR!

Blackmagic URSA Mini From      £2,409*

All models include DaVinci Resolve 12.5

Studio for editing and color correction.

*SRP is Exclusive of VAT. Electronic Viewfi nder, 

lens and accessories sold separately.



e control of Apple’s latest little marvel
he iPhone 7 is finally here, and

with it comes some serious

power. On the outside, the

difference from the iPhone 6s

might not seem all that big, but

it’s what’s inside that counts. There’s an

incredible new processor, a new Home button

and a clever design that makes the whole

thing water resistant. Then there are the new

cameras, which offer better photographs

than anything we’ve seen before from an

iPhone. The iPhone 7 Plus even has an extra

telephoto camera lens for more zoom. It’s a

photographer’s dream, but it’s also great for

selfies thanks to the 7-MP front sensor. There

are stereo speakers for improved audio, and

– according to some very smart people – the

best smartphone display ever made.

Of course, when you add iOS 10 into

the mix, you’re left with what is undoubtedly

the best iPhone ever made. Some may look

at it from afar and say that it looks the same

as the iPhone 6 and 6s, but we know better.

We know what this thing can really do.

That’s why we’ve been spending some

quality time with the latest iPhone – we’ve

been digging up the best hidden tips, secret

hacks and powerful tweaks for your iPhone.

Thanks to the unique new features of the

iPhone 7, like a customisable Home button

and improved cameras, some of these

features will be exclusive to the new device.

But don’t despair! Many of these tips and

tricks will also help power up older devices,

so you can really make the most of your

iPhone running iOS 10.

1 Water 
resistant?

Both new iPhones are rated 

IP67, which means it should 

survive for 30 minutes when 

submerged up to a metre 

in water. Apple calls this 

‘water resistant’ – but 

we consider that 

waterproof.

14

77 Power tips for iPhone 7



Master the iPhone 7’s 
amazing cameras
The best and most portable you own by far

The best shooting
and editing apps 
available for iPhone 7

Optical zoom

5 The iPhone 7 Plus has a second 

camera lens on the back, offering 

optical zoom for the first time ever. 

Tap the new icon on-screen to switch 

to the telephoto lens.

Time-lapse

7 Swipe all the way to the left on 

the camera options and you can 

activate Time-lapse mode. This takes 

shots every second or so, then merges 

them together automatically.

Digital zoom

9 You can pinch on 

the screen to use the 

iPhone’s digital zoom – this 

works really well when 

combined with the second 

iPhone 7 Plus camera, to 

give up to 10x zoom! 

Make it smooth

4 In the iPhone’s Settings 

app, under Photos 

& Camera, you’ll find an 

option to up the frame rate 

of your videos. You can 

shoot at 4K in 60 frames 

per second on iPhone 7.

Exposure control

3 Tap on your phone’s 

screen to get the best 

focus point for your shot, 

and this slider will appear. 

You can drag it up or down 

to manually adjust the 

exposure of your photo.

Edit Live Photos

2 With the iPhone 7, you 

can edit Live Photos 

after you’ve taken them 

without iOS first making 

them static images. Just 

tap Edit to crop, add a filter, 

adjust lighting and more.

Take control

8 
Tap and hold on the 

screen when you’re 

taking a photo and the 

camera will lock the focus 

and exposure to that point, 

so you can get even more 

creative with your shooting.

Quick access

6 The lock screen has changed in 

iOS 10, but you can still quickly 

access the camera. Now, you can 

simply swipe from right to left on the 

lock screen to go straight there.

Five camera 
apps to 
turn you 
into a pro

ProCam 4 £3.99/$4.99

10 This powerful camera 

app enables you to 

control shutter speed and 

ISO, shoot and save in RAW format, 

and use a dedicated low-light mode 

which really takes advantage of the 

iPhone 7’s new sensor.

Pixelmator £3.99/$4.99

11 Import photos, 

paint on them with 

brushes, cut them up and 

separate them onto different layers, 

then edit each layer into something 

fantastic. This is a fully-formed 

photo editor right on your iPhone, 

featuring a large selection of tools.

Lightroom Free

12 This photo editor is 

even better if you are 

an Adobe Creative Cloud 

subscriber. Members get brilliant 

extra features like selective local 

adjustments that let you tweak 

specific areas of your shot.

Camera+ £2.29/$2.99

13 Camera+ offers 

controls that the 

iPhone’s own camera 

should include. This includes a 

stabiliser shooting mode to get 

steady shots with the iPhone 7’s 

optical image stabilisation, and the 

unbelievable Clarity filter. 

Instagram Free

14 A new, revamped 

version of Instagram 

is on the way, which will 

take advantage of the iPhone 7’s 

improved colour range on both 

its front and rear-facing cameras. 

You can also take Live Photos and 

share them on your feed.

15

You can change the speed of the slow-mo video you capture in your 
iPhone’s settings. Higher frame rates will make videos even slower.15



77 Power tips for iPh

Power 
up your 
incredible 
Home button
Get more from the new, 3D Touc

enabled Home button

Apple has done something quite surprising with iOS

10 – it has changed the way you unlock your iPhone.

Now, you need to press the Home button and scan

your fingerprint to unlock your device; and of course,

that same fingerprint enables you to pay using Apple

Pay as well. Here’s how to set up your fingers with Touch

ID, and get started with the safest and fastest way to pay

you’ve ever tried.

Add fingerprints

17
Open Settings and choose Touch

ID & Passcode. If you haven’t

activated Touch ID already, switch it

on and add your first fingerprint by

following the instructions on-screen.

Teach it more

18
You can scan up to five prints, but

if you want improved accuracy

for a single print, use it on all five slots.

That way, no matter how you scan it,

your phone will know who you are.

Activate Apple Pay

19
Make sure the Apple Pay slider 

is switched on at the top of the 

Touch ID menu. Then go back into 

the main Settings and choose Wallet 

& Apple Pay to add a card.

Pay for stuff

20 
Once you’ve set up your card, 

you can double-press the new 

Home button to activate it. Then just 

tap your phone to the terminal and 

scan your thumb!

Choose your
click level
Customise feedback
from the Home button

21
Apple’s Taptic engine helps

to power the iPhone 7’s 3D

Touch Home button, providing a

vibration as feedback when you

press the button hard enough to

activate it. And, like many things

on iPhone 7, you can customise

the strength of this vibration in the

Settings app until you’re happy

with how your iPhone feels in your

hands. Here’s how…

1 See your options
There are three levels of Taptic

feedback that you can get when

you press the new Home button. To

choose the right one for you, open

Settings, choose General and then

tap Home Button.

2 Try them out
The standard setting is number 2, 

which gives a slight vibration when 

you press the button. If you want 

more or less feedback you can try 

options 1 or 3 with a quick tap on 

the screen.

3 Test it out
When you select each option, you can 

press on the Home button to test it. 

This won’t close the Settings app – it 

will just let you feel and try out the 

new setting. When you’re happy, tap 

Done to save.

16
Force restart

Without a physical Home 

Button, how you force an 

iPhone 7 restart is different. You 

need to hold down the Lock 

and Volume Down buttons 

together to reboot or enter 

Recovery mode on 

your phone.

16



1 Back up & unpair
On your old iPhone, select the My

Watch tab and tap Apple Watch>

Unpair Apple Watch. This will

back up your Watch, so keep both

devices close until it’s unpaired.

2 Switch iPhones
Back up your old iPhone to iCloud,

and start up your new iPhone

7. Restore your iPhone from the

iCloud backup and all data will be

carried over, including Watch data.

3 Start pairing
Once done, open the Watch app

from your new device and tap Start

Pairing. Pair the Watch like normal,

then choose Restore from Backup

and pick your recent backup.

22 Re-pair your Apple Watch
How to switch your Watch over to a new iPhone

Customise
your widgets

23
Swipe to the

right to open

your Widget view, then

scroll down and tap

Edit. Here, you can

add and remove

widgets and organise

them to access what

you need instantly.

Control
your Home

24
Add the new

Home widget

and you can control

connected smart

devices from your

lock screen as well.

You’ll need to set them

up in the Home app

first, though.

Control
Centre

25
You can also

access Control

Centre on the lock

screen. You can

now 3D Touch on

the Flashlight to get

brightness options, and

the camera for different

shooting modes.

Create a personalised
lock screen experience
Make the new iPhone lock screen your own

Essential 
iPhone 7 
Settings 
tweaks
Uncover some neat 
hidden features

iOS 10 has introduced a 

whole selection of useful 

options that are hidden by 

default, and that many people may 

never even realise exist. From more 

detailed Wi-Fi troubleshooting 

information in the Settings app to 

the option to send low-quality 

images over Messages to save 

mobile data, there is plenty to 

customise. Here are five top tips.

Delete unwanted music

26 In Settings, you can activate 

Optimised Storage for music. 

This will limit the size of your Music 

library by deleting the songs that 

you don’t listen to from your device 

when your storage is low.

Hide unused apps

27 You can now – finally – hide 

Apple’s pre-installed apps 

from the home screen. Tap and 

hold on an app icon as you would 

to delete an app, then tap the ‘x’ in 

the corner. This doesn’t delete the 

app, just hides it.

Announce calls

28 In Phone options in the 

Settings app, you can 

activate a setting which will have 

Siri announce who is calling at 

different times. You can set options 

like only announcing when using 

headphones, too.

Handwrite messages

29 Messages has been given an 

upgrade, and you can now 

handwrite messages to friends. 

Just open a conversation and turn 

your phone sideways to open, then 

scribble to write a message.

Set your bedtime

30 
You can now set a bedtime 

in the Clock app. Set an 

alarm time and how long you 

want to sleep, and the app will give 

you a reminder when you need to 

go to bed, plus a gentle wake-up 

in the morning.

“You can add and remove widgets 
and organise them to access what 

you need instantly”

17

You can activate Raise to Wake on iPhone 6s, iPhone SE and iPhone 7. 
Then, all you have to do is lift up your iPhone for the lock screen to appear.31



Enhance your Apple 
Music experience
Master the all-new Apple Music app

With iOS 10, Apple introduced a 

completely redesigned version of the 

Music app. The new app is more 

streamlined, and is dedicated to bringing 

new music to the forefront of the user 

experience. If you’re an Apple Music 

user you’ll get even more benefits, plus a simpler 

interface – especially if you’re using an iPhone 

7 with 3D Touch. New playlists will offer you 

songs based on your favourites and the songs 

you’ve recently listened to, so you’ll always have 

something to tune in to.

See the 
lyrics

36 You will also see 

a Lyrics option 

for compatible songs. 

They will appear in-line 

with the rest of the 

interface, so you can 

check them quickly 

or have a proper 

sing-along.

Scroll 
for more

35 Tap the Now 

Playing bar at 

the bottom and you 

can control your music. 

However, you can also 

scroll down for more 

options, such as Up 

Next, and Shuffle and 

Repeat controls.

Refine 
For You

34 Pick a playlist 

that you like the 

look of and hit play. 

As you’re listening, 

3D Touch on a song, 

then use the Like or 

Dislike buttons to help 

Apple Music learn 

your preferences.

Pick a
playlist

33
In the For You 

section of Apple 

Music, you’ll see two 

playlists at the top 

of the screen – My 

Favourites Mix and My 

New Music Mix. Pick 

one of these, or scroll 

down for more options.

Messages gets a
major upgrade

Messages has been given

a huge overhaul, and it’s

now a powerhouse in

social communication. Dozens of

new features enable you to chat to

friends in new ways, whether it’s

sending new emojis, reacting to

messages or posting stickers. But

here are a couple of power features

you might’ve missed.

Send an image

37
In a message thread, tap the 

arrow at the top left of the 

keyboard to see more options. Tap 

the camera and you will be able to 

take a photo, browse your shots, or 

open the camera for more options.

Mark it up

38  Tap the image in the message 

box to see it full-screen, then 

tap Markup in the bottom left. You 

can now draw or write on the image, 

type text, or magnify certain parts 

using your finger.

Add more apps

39 You can power up Messages 

more with dedicated Message 

apps. Tap the App Store icon in the 

menu and you can download sticker 

packs and even games that you can 

play with friends in your thread.

Become a
Messages
expert

32
Automatic 
downloads

Users can now choose to 

automatically download content 

you’ve added to your Library, even 

if you added it on another device. 

This means it will be available 

offline, no matter which 

device you’re using.

18
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Filter your mail

40 This new button in the 

bottom left allows you to 

filter out all the messages that 

you’ve already read, so you can 

focus on the unread emails that 

you want to get through.

Dock message

43 If you need to check 

something elsewhere in 

Mail, tap and hold on the bar at the

top of the email and drag it down. 

The message will be ‘docked’ at 

the bottom of the screen.

Control the filter

41 Tap the centre of the bottom

bar with the Filter active to 

see a range of options. You can 

choose the mailboxes included, 

select whether you’re the recipient 

or just copied in, and more.

Write more

44 
You can now browse your 

mailbox like before, and 

even start a second message by 

tapping Compose again. Tap the 

docked message to see all your 

messages, just like Safari tabs.

Write a message

42 Let’s start writing a couple 

of messages at once. To 

begin with, go back to your mailbox 

and tap the Compose button in the 

bottom right of the screen to open 

a new, blank message.

MailDrop and 
iCloud Drive

45 
Double-tap in your message 

and you can tap right on the 

pop-up menu to add an attachment. 

You can browse iCloud Drive, and 

large files will send via MailDrop.

Mail finally got some love from 

Apple in the latest update, 

adding a range of features that 

heavy users of the app will be sure to 

appreciate. iPhones are often used as 

business phones, making email a key 

part of the device, but even if you’re just 

a causal user there is bound to be a 

feature here that you’ll use at some 

point. Whether it’s utilising MailDrop to 

send huge attachments or writing 

multiple emails at once and keeping 

them all open, these clever tricks will 

help you power up Mail.

Pro tips 
for heavy 
Mail users
Mail gets some neat 

tricks in iOS 10

Third-party 
Siri time-
savers
Get more from 
Siri with these 
app extensions

Siri has gained a lot of 

extra abilities in iOS 10, 

and most of them come 

thanks to Apple allowing third-

party developers to add voice 

commands for their apps. Here are 

some of the best commands that 

you can use to complete tasks 

without opening the app 

in question.

Get a ride

46 You can order an 

Uber or a Lyft driver 

via Siri – say something like 

“Get me an Uber to Trafalgar 

Square” and a map will appear 

showing you the estimated price, 

and a map. Very convenient.

Send a message

47 You can use third-

party messaging 

apps like WhatsApp and 

LinkedIn to quickly send messages 

through Siri. You just have to 

specify the app in your speech to 

do this.

Start a Runtastic run

48 If you just want to 

get out there and 

start running, you can 

instantly start a workout with 

Runtastic by saying “Start a 10km 

run with Runtastic”. Confirm the 

run, and off you go!

Send money

49 Apps like Square 

Cash enable you to 

quickly send money to 

friends, and now you can do it in 

Siri, too. Say “Send John £10 for 

dinner using Square Cash” and you 

can verify with Touch ID to send it.

Make a Skype call

50 Now that Siri and 

iOS supports VoIP 

calling, you can use apps 

like Skype and WhatsApp to 

quickly call your friends over an 

internet connection. Just say “Call 

Phil on Skype”.

19

You can quickly unsubscribe from an email mailing list in Mail – just tap the 51



Apps that utilise
the brand-new
speaker system

The iPhone has

never sounded

so good
The iPhone 7 has a trick up its

sleeve. Sure, there are now two speakers

on the bottom of the iPhone (bye,

headphone jack!), but the real news comes

at the top of the device. Now, instead of

a small speaker that is only audible when

held to your ear, you’ll find a full-sized

speaker that can pump out some serious

volume. The result is a stereo setup that

produces twice the volume of the iPhone

6s, and does an incredible job with stereo

sound. Here are some great apps to test

the speakers out.

GarageBand £3.99/$4.99

55
One of the best

ways to make

music on your iPhone

is also one of the best apps to

use in stereo. You’ll hear every

drum beat, every string and

every keystroke as you tap out

a masterpiece.

Netflix Free

56
With so many

epic movies and

TV shows to watch,

Netflix will be able to take

advantage of the extra volume in

the iPhone 7 to give you a proper

stereo experience – even on the

small screen.

Figure Free

57 We’ve been huge 

fans of Figure for 

ages, and now its 

awesome beat-making and 

remixing abilities can finally live 

the stereo dream on iPhone. 

Prepare to get hooked on this 

brilliant music-maker.

Must-have iPhone 7 accessories
Power up your iPhone 7 with these awesome additions

AirPods £159/$159

www.apple.com

59
Apple’s new wireless

headphones pack in

some smart tech. They’ll

connect as soon as you

open the case, have

proximity sensors that stop

music when you take them

out, and can activate Siri

with a double-tap.

Philips Hue
bulbs £149.99/$179.99

www.amazon.co.uk

63
These smart 

lightbulbs 

can be controlled from 

your iPhone, iPad and Apple 

Watch, and change colour at 

the tap of a screen. They’re 

also fully compatible with 

the new Home app for 

easy control.

Lightning
Audio + Charge
RockStar
£34.99/$39.99

www.belkin.com

60
This will help when

you want to charge

your iPhone but don’t want

to stop listening to your

tunes. Plug this in, then

charge through one port

and keep listening through

the other.

CM4 Q-Card
Wallet Case
£34.99/$39.99

www.amazon.co.uk

61
This case offers

a good amount of

protection, and also allows

you to carry your cards and

your iPhone in one place.

Even better, you can use a

credit card as a kickstand

by slotting it into the case.

Beats Solo3
Wireless
£249.95/$299.95

www.apple.com

62
These wireless

headphones use

the same wireless tech as

Apple’s AirPods, meaning

they’ll pair with whichever

device you’re using just by

holding them close. They’ll

sound great, too.

Make the most
of best-ever Wi-Fi
and 4G LTE
On iPhone 7, the
internet just got faster

WhatsApp Free

52
Whether you’re watching videos

or sending photos from the

weekend to your friends, WhatsApp is

one of the best everyday apps to use if

you want to notice the faster 4G of the

iPhone 7 in action.

Google Chrome Free

53
Browsing the web over 4G is

about to get faster with iPhone 7.

Sites will load more quickly, which will

be especially noticeable on pages with

loads of images or videos.

YouTube Free

54
One of the best ways to test your

iPhone’s speed is to watch a HD

video using your new iPhone 7 Plus.

Check it out at 1080p and marvel at the

ease with which your phone handles

the buffering.

58
Always hear the call

If there’s one contact you always 

want to hear calls from, open 

and edit their Contact card. Tap 

Ringtone and enable Emergency 

Bypass. Now your phone will 

always make a sound, even 

if on Do Not Disturb.

20
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Sky Guide £2.29/$2.99 

Rather more tranquil fare can 

also take advantage of the 

new iPhone screens. Sky Guide has 

always been a gorgeous astronomy 

app, but its colours pop on iPhone 7 as 

you explore the virtual night sky. The 

app utilises 3D Touch; a Peek enabling 

you to X-ray a section of the sky, and 

Pop expanding the filter to full-screen. 

A Quick Action on the home screen 

icon displays a compact version of the 

app’s widget, for speedy access to rise 

and set times of key celestial bodies.

Showcasing the best of the 
revamped Retina display
Show off that stunning display with Sky Guide 

Experience 
the best 
of the A10 
Fusion chip
Play hard with the 
iPhone 7’s powerful 
new processor

Oz: Broken Kingdom Free

72 You know a game 

looks good when 

Apple uses it to show off 

their new iPhone display at the 

official keynote. This fun action 

title uses some seriously 

advanced graphics, which 

look incredible on the iPhone 7’s 

Retina display.

Geometry Wars 3
£7.99/$9.99

73 You can’t get more 

colourful than 

Geometry Wars, which 

throws you into a Tron-like world 

and throws dozens of shapes at 

you to shoot. It’s crazy, explosive 

and it looks great. A must-have for 

any iPhone 7 gamer.

Riptide GP: Renegade
£2.29/$2.99

74 To really test the 

new processor, we 

like to push it with a game 

that goes really quick. Riptide GP 

is a speedy, jetski racer that – 

thanks to the iPhone 7’s 

waterproofing ability – you can 

play in actual water.

The Path To Luma Free

75 Gorgeous 3D 

worlds won’t be 

too much of a struggle 

for the A10 chip, but the game 

looks stunning on the iPhone

7’s screen. Plus, the message

at its core is important

– environmental protection.

Rayman Adventures Free

76 This console star 

finally has a game 

worthy of his name on the 

iPhone, and the bright, colourful 

world of Rayman really pops on 

the iPhone 7 display. There are 

loads of action-packed levels and 

it’s great fun.

Nest 
Thermostat 3 

£249/$249

store.nest.com

64 It’s expensive, but 

this smart home 

accessory will make keeping

your house warm easy. 

Control it from your iPhone’s

Home app, set routines 

easily, and even track how 

much energy you save.

Twelve South 
HiRise 2 

£49.99/$59.99

www.amazon.co.uk

65 Twelve South is 

one of our favourite 

accessory makers, and 

the HiRise 2 shows exactly 

why. Designed to match the 

iPhone’s design, the stand 

holds your iPhone securely, 

while looking great.

JBL Charge 3 

£149.99/$149.95

www.jbl.com

66 This speaker isn’t 

just a speaker – it 

can also charge up your 

device fully, and still have 

enough power left to pump 

out an hour or so of music. 

Even better, it’s IPX7 

waterproof so you can 

even take it swimming.

Colour me impressed

67 On the new iPhone 7 screen, 

colours look better than ever. 

One of the best apps to showcase 

it is Sky Guide, which gives you an 

animated look at the night sky.

Apple Watch magic

68 Do you have an Apple Watch? 

The Watch app for Sky Guide will 

notify you when the ISS is passing over, 

and show you the activity of the Sun.

Peek at it

69 The app supports 

the iPhone 7’s 3D 

Touch brilliantly. Press 

gently and you can activate 

a Peek, which lets you 

scan parts of the sky with 

a range of different filters, 

such as X-ray.

Pop it out

70 Press firmly on the 

screen and you’ll use 

the Pop technique. This will 

expand the Peek scanner 

into full-screen mode so 

you can take a closer look.

App shortcuts

71 On the home screen, 

you can use a 3D 

Touch to display a compact 

version of the app’s widget, 

which will quickly show you 

rise and set times for all 

kinds of celestial bodies.
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The iPhone has a brighter screen, but you’ll only see that extra 25 per cent if 
you go to Settings>Display & Brightness and switch on Auto-Brightness.77



The camera has received another high 

profile boost in the iPhone 7, and the 

results are typically brilliant

Each new iPhone 7 ships with  

iOS 10 pre-installed, and it’s a  

match made in heaven 

The iPhone 7’s display features a wider 

colour gamut and is 25 per cent brighter 

than previous generations

“These sleek, 
darker versions 
bring new style 

to a product 
that is already 
something of  
a statement” 

22



Key features

Learn more

 

 

 

 

iPhone 7/iPhone 7 Plus

A closer look at Apple’s 
vision for the future

It’s fair to say AirPods look and feel 

slightly alien when first encountered. 

Looking much like EarPods just with 

the cords cut, you’re not entirely sure 

what to expect, but the truth is they’re 

going to be a viable listening option 

when they go on sale at the end of 

October. The carry case they come in 

not only serves as a charging point, 

but also as the Bluetooth hub for 

connecting to your phone. Open the lid 

and a connection is instantly made. 

The Pods themselves are comfortable, 

and house an impressive amount of

technology, with touch sensitivity for

activating Siri as well as microphones

for capturing your voice for commands

or taking calls. The W1 chip housed

inside the AirPods also powers the

sensors in each ear, which is able to

identify when the AirPods are and

aren’t in your ear.

Space Grey is no longer a colour 
option, and has been replaced by 

Black and Jet Black

23



The improvement in the camera’s ability to capture detail is clear,

with the different parts of the cactus shown in greater sharpness than

what you would get on the 6s

Low-light photography is now markedly improved – the iPhone 7

is quicker to increase exposure and find light for the photo.

Our test shots showed some impressive results

No matter what colour iPhone 7
you pick, Apple has a range of

accessories ready to go

100%100%

For the first time  
ever, your new  

iPhone is waterproof

The antenna band across the top 
has disappeared, but the camera 
bump is still there

iPhone 7/iPhone 7 Plus Review
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Geekbench
The A10 Fusion chip inside the  

iPhone 7 and 7 Plus has made 

the phone sharper when it comes 

to general productivity and more 

capable of handling console-quality 

gaming. But how does the new 

processor stack up against previous 

generations? Let’s take a look.



trepidation does remain until you fish it from a sink 

for the first time and see it still works just fine. Until 

that scenario, the iPhone and water still seem like 

unlikely companions.

Though not a direct part of the waterproofing 

process, but helping complete the process 

nonetheless, is the redesign of the Home button. 

Now, much like the most recent version of the 

MacBook trackpad, the Home button on the iPhone 

7 and 7 Plus is a solid entity, slightly sunken to 

still differentiate it from the rest of phone face, but 

it no longer moves like a button. Instead, Apple 

has extended the Taptic Engine to the button, 

responding to your press with vibration feedback 

to simulate the sensation you get from pressing 

a physical button. The effect is impressive and 

instantly comfortable. Not only that, the Taptic 

Engine also responds and nudges you during a 

range of tasks – as you zoom in on images and as 

you scroll menus, for example. It makes the phone 

feel more responsive in your hand. 

But most interestingly is Apple’s decision to 

open up this Taptic Engine to developers. The 

result is apps and games now being able to take 

advantage of this feedback system to create more 

immersive mobile interactivity and gaming. We’ve 

been fortunate enough to try the new version of 

Zombie Gunship that supports this system, with 

your machine gun fire now being fed back through 

the iPhone. Remember how different and engaging 

it was the first time you felt the Rumble Pak on your 

N64? This is 2016’s version. 

The big picture
The camera on the larger 7 Plus is without doubt the 

more eye-catching of the camera setups, but there 

has been a noticeable improvement on the iPhone 

7 too. The larger f1.8 aperture means up to 50 per 

cent more light is let into the lens, and the main 

improvement is in low-light photography. The 7 is 

a marked step forward when it comes to capturing 

images in dark conditions – a long-standing iPhone 

issue. In our strict testing we didn’t find a situation 

where we couldn’t capture a satisfactory shot, both 

indoors and outside. 

This improvement is helped by the increase to 

12 megapixels, and optical image stabilisation and 

longer exposure. Images are now noticeably sharper 

and more detailed. Colour is improved too, though 

this is helped by a once-again improved display on 

the iPhone 7. 

So much of smartphone use today is built  

around the camera, and for many that means 

selfies. The seven-megapixel FaceTime camera, 

complete with Retina Flash, provides the best  

selfies we’ve seen from an iPhone.

The audio question
And so we come to the biggest talking point  

of the iPhone 7 – the piece of information that  

jumped to the top of every news story – there’s  

no headphone jack on the iPhone 7.

But perhaps the bigger story is actually how  

little you notice it in day-to-day use. Many iPhone 

users are happy to stick with the EarPods that  

come bundled in the box for music listening.  

Those users will be unaffected here because you 

simply just plug your new EarPods into the Lightning

port and go about your day. A minor added detail, 

the Lighting connection is more robust, so should 

you find yourself plucking your iPhone from a  

pocket via the wire or trying to catch it mid-fall,  

the Lightning connection holds firm much more  

than the 3.5mm line. 

If you happen to still be attached to your  

3.5mm-line headphones, there’s an adaptor in  

the box to easily connect them to the 7 without 

much added cable. The truth is, that’s it. There’s 

no real added inconvenience in everyday use. For 

many, the daily music or podcasting listening routine

will hardly change. 

A step forward
The iPhone 7 might not be the full step forward 

many would have hoped for, with more iterative 

touches having been implemented, but crucially, 

improvements have been made to a smartphone 

that was already one of, if not, the best around. 

The new A10 Fusion chip has sharpened up the 

iPhone 7’s reactions, so that combined with iOS  

10 this is the most fluid iPhone experience yet.  

The new lock screen in particular is an 

organisational highlight. Battery life is not noticeably

better than the iPhone 6s, and there is an argument

that no clear upgrades are visible to those toying 

with the idea of moving up to the 7.

But Apple has arguably been out in front since the

iPhone 6, and with the steady improvements made 

over what is now two more generations of iPhone, 

we have reached the best iPhone Apple has ever 

made – but perhaps it shouldn’t have taken this long

to get here.

The iPhone 7 is a step forward, improving in key areas – most notably the camera – but if you’re 

already using a 6s, you might be better off waiting until next year. 

Verdict
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Battery life
tested

Part of the 7 and 7 Plus update saw

mentions of improved battery life. On

the 7, this is said to be as much as an

extra two hours per charge – though

this varies depending on how you’re

using your iPhone. However, in day-

to-day use the increase is not hugely

noticeable, and you’re still likely to find

yourself charging your iPhone at night.

iPhone 6 users will see a massive

difference though. Two years in battery

technology is obviously huge.

hours
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hours

minutes
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45
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Plus
iPhone 7

“Remember how 
different it was 

the first time you 
felt the Rumble 

Pak on your 
N64? This is 

2016’s version” 
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Reader Survey

Get 10% off our books and magazines

Get access to an exclusive monthly subscription offer

Become eligible for exclusive competitions & free gifts

Take our three-minute survey and…

Have 
your
say!

Join our team today!

We love making iCreate and hope you enjoy 

reading it every month. This year we’re keen 

to hear what you think of the magazine 

again, by inviting you to take part in a quick, 

three-minute reader survey. This is your 

chance to help shape the future of your 

favourite magazine. We’re looking forward to 

hearing what you’ve got to say! 



 Last year we used your input 

to make some fantastic 

improvements, including…

Four changes 
you asked for 
in 2015…

Complete our survey & join the team today

icreatemagazine.com/survey-2016

Complete
 survey

Step 1
Get 

involved

Step 2
Earn 

rewards

Step 3

1 Focused features
80 per cent of you told us you 

weren’t making the most out of 

iCloud, so we compiled the ultimate 

d t nding the cloud.

Buye
Our readers buy on our

recommendation, so we created our 

i rst-ever Apple Buyers’ Guide issue 

to point you in the right direction.

3 More hardware reviews
You asked for extra hardware 

reviews and recommendations, so 

we went and created our stunning 

Accessories spread.

4 Extra iOS content
Over 90 per cent of you own 

both an iPhone and iPad, so we 

made sure there were more iOS-

focused tutorials in the mag.

Exclusive discount subscription to the magazine
Incredible savings for new and existing subscribers 

Plus Free delivery direct to your door

Exclusive savings on mags and books
Get a 10% discount code to use at our online shop

Competitions
Get the chance 

to enter exclusive 

competitions for 

money-can’t-buy prizes

Free gifts
Become eligible for 

free gifts including 

digital editions for 

phones and tablets

Have your say
Gain a place on our 

reader panel, giving 

you regular input on 

the magazine

Take part in our 2016 reader survey and yo

can enjoy these fantastic benefi ts

Reader Survey

Only 
takes 3 
mins!



Key features

Learn more

Apple Watch Series 2

apps open more 

responsive”

Apple Watch Series 2



The casing of Apple Watch Series 2 is approximately 1mm thicker

than before, but in use you won’t notice the difference

The stunning design is otherwise 

virtually unchanged

How is 
Apple Watch 
waterproof?
Rebuilding Apple’s 

smartwatch to keep  
the water out

Apple has had to essentially take the 

Watch apart and rebuild it internally in 

order to solidify it and keep water out. 

However, the speaker grille remains 

in place and open – as is necessary 

in order to allow the speaker and 

microphone in the Apple Watch to 

function. Instead, Apple has devised 

a feature that, after interaction with 

water, a sequences of beats and 

pulses use sound waves to push any 

excess water out of the device. 

This is backed up by a waterproof 

mode, which is activated when users 

confirm they are starting a swim-based 

workout. This locks the screen too, 

with the device only unlocking once 

the Digital Crown has been turned, so 

no splashes are mistaken for swipes or 

taps on your Watch face. The result is 

worry-free exercise, with your powerful 

wearable tracking you all the way. 

remain familiar to those who have used an Apple 

Watch already.

Performance
Raise your wrist or press either the Digital Crown 

or Home button and you begin to see the changes 

that have been made for Series 2. This is partly 

powered by the watchOS 3 update, which has 

done a very good job of tidying up and tightening 

the Watch experience, but crucially has been lifted 

to a new level by the 

improved internals 

in Series 2.

The Series 2 now comes with a dual-core 

processor for the first time, and the rapid increase 

in response it evokes from the Watch is actually 

startling. The screen responds faster, apps open 

more quickly and the user interface is much more 

responsive. The icon map that appears when you 

press the Digital Crown is noticeably smoother to 

navigate, as is the jump in and out of apps. The 

Watch feels much more vibrant now. 

Also, the increased power means better, more 

detailed apps can run on the Watch; Night Sky, 

for example, enables users to closely examine the 

constellations above them. Yes, it is questionable 
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just how necessary such an app is, but looking at 

the potential, there is plenty to be pleased about 

from a performance point of view. 

Swim proof
As a wearable, the Apple Watch remains best suited 

as a tool for health, fitness and well-being. Apple 

knows this, which is why the Series 2 has been 

made water resistant up to 50 metres. It’s a huge 

step forward for the device; no other device of equal 

complexity and power can boast such a feature, and 

that is crucial to locking out the fitness market. 

Two aspects about the new waterproof Watch 

are especially pleasing. The first is the actual act of 

taking it swimming with you. The updated Workout 

app is able to track you whether you’re in a pool or 

on an indoor swim – with the former you can set 

the pool length and track laps. But actually being 

able to keep your Apple Watch on is great, because 

not only can you still see all your notifications come 

through, you are no longer in the irritating situation 

of having to remove your powerful smartwatch and 

fitness tracker as you begin to exercise. This frankly 

ridiculous juxtaposition is now gone, and suddenly 

Fitbit and Misfit users aren’t quite so vocal about 

functionality anymore. 

The second thing to love about the waterproofing 

is the ingenious way the Series 2 is able to get rid 

of any water that may become lodged in it. This 

revolves around the only opening not sealed on the 

device: the speakers. Using the physics of sound 

– the speakers create sound by pushing air out of

them – the Watch Series 2 has a short sequence of

beeps that is triggered when you remove the device

from swim mode. The Apple Watch locks itself

when you confirm you’re swimming and can only be

unlocked with several, purposeful twists of the Digital

Crown. The sequence of beeps that follows pushes

any excess water out of the device in a matter of

seconds. It’s a smart piece of tech and in truth

something of a party trick we have been only too

keen to show off. 

Movement
The Series 2 is a great device for tracking and

logging your movement. What makes it even

better at doing so is that, for the first time, GPS is

now built into the device for tracking all of your runs

and swims.

What this means above all else is that if you

don’t want to, you no longer need to take your

iPhone with you on your run in order to track the

distance you’ve covered, as the Watch can do

it itself. Of course this also helps in day-to-day

navigation, but it’s much more profoundly useful as

an exercise tracking tool.

The device’s place at the top of the fitness-

tracking pyramid is enhanced by the special

Nike+ version of the Watch, which comes with

lightweight wristbands and special Nike+ Run Club

app-based watch faces, designed to help you jump

into your workout quicker. 

Apple Watch
Aluminium
From £369/$369
The ‘entry-level’ Watch

in terms of price, the

aluminium casing comes

in a range of colours,

including Space Grey

and Rose Gold – both of

which look great with

sport bands.

Apple Watch
Stainless Steel

From £549/$549
Providing a more glossy, 

polished look than the 

aluminium case, the

Stainless Steel Watch also 

comes with more detail on 

the Digital Crown, with the 

centre of it coming with a 

black finish.

Apple Watch
Nike+

From £369/$369
Special Nike+ Run Club 

themed Watch faces are 

built in, while there are 

a range of dedicated, 

lightweight Nike watch 

bands too. Anyone who’s 

ever used a FuelBand will 

find the design familiar. 

Apple Watch
Hermes

From £1,149/$1,149
You can rely on Hermes 

watch faces for added  

style and – naturally – a 

range of high-quality 

leather straps to go with 

it. This is the Apple Watch 

of choice for more of a 

statement wearer.  

Apple Watch
Edition

From £1,249/$1,249
Apple has a new edition 

to its premium line-up this 

year with the introduction 

of the white ceramic finish, 

complete with a ‘cloud’-

coloured wristband.  

The OS remains the  

same, however. 

Apple Watch Series 2
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Built-in GPS
For many fitness-loving Apple Watch 

users, this is the crowning new feature 

of Series 2. Built-in GPS means that 

Apple Watch users heading out for a 

run or swim can now choose to leave 

their iPhone behind if they so wish. 

The Watch picks up your location 

instantly and then shares data with 

your iPhone once you’re back home  

so you can see your route. 

This is a new level of freedom that  

will delight many – no more arm  

straps or awkward headphone wires. 

The result is much freer running or 

swimming, without having to worry 

about protecting your iPhone. 

The GPS can also be applied to other 

apps – there’s a new hiking app, for 

example, so users can do more with 

their Watch without necessarily having 

to turn to their iPhone for help. 



A leap forward for wearables, jumping to the front of the smartwatch queue,

while also offering one of the best fitness setups around.

Verdict

Relevance
Using the Apple Watch every day has also become

distinctly easier with the Series 2. As already

discussed, the internal redesign has greatly

enhanced and improved the user experience. Apps

load so much faster – Twitter, for example, feels

like a different app on the Watch, with the feed and

trends loading in a fraction of the time.

The introduction of the Dock feature, where much 

like on the iPhone you can quickly swipe through 

your most recently used apps, is a good example  

of how the Watch has been made much more useful 

as a productivity tool and organiser. No longer 

judged for not having a big enough screen to be 

productive on, instead you now feel as though you 

can turn to it for quick-fire tasks.

Apple has also improved the Watch’s display, 

making it twice as bright so that it’s easier to see in 

a range of lighting conditions, most crucially when 

you’re outside in direct sunlight. 

The processor and performance has also

had a subtle effect on battery life, with a single

cycle of the Watch’s battery lasting noticeably

longer in our testing. Again, ideal for the extra

activities you might now find yourself compelled

to do with the Watch on your wrist.

In many ways, this is the Apple Watch we

should have got the first time around. It feels

far more relevant and usable, building on the

idea planted by the first generation – though

in truth this was an idea that many are still to

buy into. Series 2 might change that, because

combined with the iPhone, it is now a genuinely

useful pairing. The Watch no longer feels like just

an extension of the iPhone; it is powerful enough,

fast enough and waterproof enough to be its

partner in many of the things you do on a daily

basis – even superseding the smartphone at

certain times for convenience. And that might just

well be its greatest triumph. 
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So 
what’s gone?

As well as lots of new 

additions, watchOS 3 has 

ditched a few of its previous 

features. We wave goodbye 

to the Favourites side button 

and the Glances feature, 

but luckily we can also 

bid farewell to slow 

app loads.

watchOS 3
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ince the Watch was unleashed 

back in April 2015, we’ve been 

patiently waiting for Apple to truly 

crack it. Not literally, of course, 

but in terms of finally delivering 

an operating system which matches the 

expectations we’ve come to anticipate from 

Apple. With watchOS 3, we finally have a must-

have wearable on our wrists – a device that 

helps us to look after our health, stay informed 

and communicate with the minimum of fuss.

There have been some dramatic changes. 

It’s now easier than ever to input text 

and give instant feedback to 

With t 3, your 
Apple Watch feels brand-new. Here’s how

watc  3
EVERYTHING YOU NEED TO KNOW ABOUT

an incoming message. Switching between 

watch faces is suddenly effortless and you 

can access the key controls with a simple 

swipe. You can also view your apps in a new 

Dock that actually gives a proper purpose to 

the previously little-used side button. It even 

unlocks your Mac. How cool is that?

Over the next few pages, we are going to 

delve deep into watchOS 3’s various new 

functions and how they will be keep you 

healthier, more productive and in greater tune 

with others. We’ll also look at some new apps 

and encourage you to become more familiar 

with the Watch app on your iPhone – essential 

if you are going to set up the Apple Watch to 

work just the way you’d like it.

You’ll certainly be heartened by Apple’s 

continuing support of the Watch, a device many 

critics had written off. With a cutting-edge 

Series 2 and a willingness to reassess what 

makes a good wearable operating system, it’s 

hard not to feel you’re in safe hands.
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Customise &
change your
watch face
It’s easier than ever to alter

the faces of your Watch

Apple has made a number of important changes to

the way you switch between your watch faces and

alter how they appear. You now have the option

of making changes within the iPhone’s Watch app

as well as on the wearable itself, enabling you to

take advantage of the larger screen. You can also

choose from some new faces, notably the Activity

Analog, Activity Digital, the minimalist Numerals and

a costume-changing Minnie Mouse. By expanding

the customisation options and allowing for

switching on the fly, you can create some

truly bespoke faces that fit into your various

activities and circumstances.

1 Swipe
left/right
To switch between the

different Watch faces,

you can now swipe left

or right on the display.

This is different to the

previous versions

which made you press

firmly first.

4 Use your
iPhone
You can use more face

options via the iPhone’s

Watch app. Tap the Face

Gallery tab and you’ll

see the new watchOS

3 faces as well as

featured complications

and alternatives.

2 Force
touch display
You can add new faces

by force touching the

display, swiping to the

end, tapping + and

making your selection.

To alter the looks and

attributes of a face,

select Customise.

5 Add a face
Tap a face you like

and use the on-screen

options to customise

it to your liking; you

can change the

colour, typeface and

complications to suit

your needs. Tap Add

to finish.

6 Use
the face
Your customised face

will appear in the My

Watch tab under My

Faces. Tap it and scroll

down the screen,

selecting ‘Set as current

Watch Face’. It’ll appear

on your Watch.

“By expanding
the customisation
options you can
create some truly
bespoke faces”

Rearrange 
the faces

If you want certain faces 

to be together or prioritised, 

rearrange them in the iPhone 

app. Tap Edit in My Watch>My 

Faces before holding and 

dragging a three-line icon. 

The red dots let you 

delete faces.

3 Select the 
complications
You can swipe through 

the pages for your 

chosen face, tapping 

any elements that appear 

and using the Digital 

Crown to cycle through 

the options. Click the 

Digital Crown to finish.
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Access your 
most-used 
apps quickly
Master watchOS 3’s 
new Dock

How to use your 
new Control Centre
Swipe up to see lots of actionable controls

 Do Not Disturb
Tap this to stop your Watch from 

buzzing when a notification is coming 

through. The notification will go to 

your iPhone, leaving you in peace.

 Ping your phone
Can’t find your iPhone despite looking 

high and low? You need to tap this 

button to force your handset out of 

hiding with an audible loud ping.

 Silent mode
If you’re in a meeting or trying to 

watch a movie, you may want to 

hush your Watch. This icon will 

mute and unmute all the sounds 

from your wearable.

 Battery life
You can instantly check how much 

juice your Watch has left. Too low? 

Tap this icon and activate Power 

Reserve, which turns off all features 

except for the current time.

 Airplane Mode
Quickly disable Bluetooth and Wi-Fi 

by activating the Airplane Mode with 

a simple tap. As well as protecting 

your flight, it’s great for conserving 

battery life.

 Activate AirPlay
Any stored AirPlay devices such 

as headphones, speakers or those 

snazzy new wireless AirPods can be 

connected to your Watch with a press 

of this button.

1 Add an app
You can tailor the Dock

to suit your needs by

adding any of your

favourite apps to it for

easy access. Simply

open an app that you

want to include and

press the side button

to access the Dock.

2 Keep
in Dock
The app you opened

will appear in the Dock

but to add it permanently,

tap Keep in Dock. While

here, try swiping left

and right to view other

stored apps and their

current state.

3 Remove 
an app
If you spot any apps 

that you don’t want in 

the Dock, it is possible 

to remove them, 

ensuring only your 

favourites are included. 

Press on an app, swipe 

up and tap Remove. 

Pressing the side button no longer opens the 

Friends carousel. Instead, it gives you access 

to the Dock – a far more useful new feature that 

lets you head straight to your most-used apps. 

Since the apps in the Dock sit active in the 

memory, you can view a snapshot of your apps’ 

current state and open them very quickly.
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Set up & use 
Activity Sharing
Keep yourself motivated by 

comparing your stats with friends

Having personal goals is all well and good but it’s great 

to compare your progress with others. With Activity 

Sharing, you can be much more competitive in even 

the most solitary of exercise regimes by viewing your 

friend’s targets, achievements and workouts. Since 

they will be able to see your data too, it should keep 

everyone on their toes. You can set challenges to push 

everyone to peak physical condition, and if you have a 

personal trainer, you can share your data with them too. 

1 Add your friends
Open up the Activity app on your 

iPhone and select the Sharing tab, 

then tap the + in the top right-hand 

corner and add the names of your 

friends. They must also own a Watch

to accept.

2 Open Watch app
In the Activity app on your Watch, 

you need to swipe left. Your friends 

will be listed along with a brief outline 

of their achievements. Tap their name 

for more detailed stats. You can also 

send them a motivational message.

3 Set a challenge
Scroll to the bottom of your friends 

list and select ‘Send message to all’ 

to lay down a group challenge for 

everyone to aim for. Set up individual 

challenges by choosing a friend and 

then tapping Send Message.

Do more from your wrist A quick look at other brilliant watchOS 3 features

Apple added a host of

extra functions to the

latest operating system.

You can open Find My

Friends and tap on your

contacts to see their

location, and you can add

Reminders information

to the watch faces. Here

we look at four other key

features that make your

smartwatch the best ever.

Call the emergency
services with SOS

With your iPhone 

nearby or connected 

to Wi-Fi, your Watch 

will connect with the 

emergency services when 

you press and hold the side 

button. Set up emergency 

contacts on the iPhone 

Watch app via General> 

Emergency SOS>Add SOS 

Contact and a text with your 

location will be sent to them.

Control your HomeKit-
enabled devices

As long as you have 

set up your HomeKit 

devices within the 

Home app on your iPhone, 

you will be able to use your 

Watch to conveniently 

control each one of them. 

On your Watch you can 

select your accessories and 

access various scenes as 

well as use Siri for cool, 

hands-free operation. 

Do even more
with Apple Pay

Add your debit and 

credit cards in the 

Apple Watch app of 

your iPhone and you’ll be 

able to use them to make 

in-app payments for the first 

time. Developers are being 

encouraged to build Apple 

Pay into their apps, so we 

should see this becoming 

more widely used in the 

coming months.

Unlock your Mac
with Apple Watch

Save yourself the 

hassle of typing in a 

password in macOS 

Sierra by allowing it be 

unlocked automatically when 

you approach with your 

Watch. Go to System 

Preferences>Security & 

Privacy>General, tick ‘Allow 

your Apple Watch to unlock 

your Mac’ and enter the 

computer’s password.

Hide your
activity

If you decide you don’t want

one of your friends to see

your activity, you are able to

open the iPhone Activity app

and tap Sharing. Select

a friend and

then choose Hide

my Activity.
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With the Activity app, the Watch is able to keep 

an eye on your daily levels of fitness. It will keep a

tally of the time you spend standing, moving and 

exercising as it bids to get you off your bottom and

into peak physical condition. It’s tailored to your 

body, offering stats that take into account your age,

sex, height, weight and wheelchair status, and it 

also enables you to set an activity level. Input all 

of these when you first open the app and you are

good to go.

Track workouts 
& customise 
viewable statistics
Every move you make, Apple’s 

Activity app is watching you

air users can now take 

tage of the Activity app 

a new setting that can 

ed via the iPhone’s 

p. If you select Health 

Wheelchair to Yes, 

will change the Stand 

ll, keeping a check 

mber of hours a user 

ed. It will also deliver 

me to roll’ notifications 

and allow for the use of two 

new wheelchair workouts. The 

feature was added following 

a comprehensive study of 

wheelchair use.

w 
chOS 3 
ks for 

eelchair 
rs too
atch is the first 
hair-accessible 
tracker

1 Monitor 
progress
Open the app and you’ll 

see three rings: Stand, 

Move and Exercise. 

They will tell you how 

often you stood for a 

minute, the calories 

you’ve burned and the 

time spent exercising.

2 Scroll 
for stats
Beneath the rings – 

which you’re aiming to 

complete each day – is 

a set of stats that not 

only gives you hard and 

fast figures, including 

total steps and distance, 

but graphs too.

3 Adjust 
the goals
Force press on the 

Activity app’s screen 

and select Change Move 

Goal to select how many 

calories you are hoping 

to burn each day. Just 

tap the – and + icons 

and tap Update.

4 Use 
Watch app
You can use the app 

to adjust your Activity 

settings, creating 

reminders to stand, 

allowing for changes 

to progress update 

frequency and activating 

goal notifications.

“The Watch will keep
a tally of the time you

spend standing, moving
and exercising”
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Master the new
Breathe app
Let your Watch help you to relax 

with guided breathing exercises

Apple has positioned the Watch as essential for keeping you 

fit and active, but you need to look after your mind as well 

as your body. With the Breathe app in watchOS 3, you can 

begin to feel calmer, taking a moment out of your day to bat 

away life’s stresses by following an on-screen animation that 

indicates when you need to inhale and allow the air to flow 

slowly back out again. If you prefer to close your eyes during 

your session, you can be steered by gentle taps on your 

wrist instead. You can also keep a check on your progress 

via the summary screen.

1 Alter
the time
To start a session

manually, open the

Breathe app and tap

Start. Turn the Digital

Crown to change how

long your session will

last. Select between

one and five minutes.

4 Change
Breathe Rate
You’ll be asked to take

seven breaths per

minute, but you can

alter this very quickly by

selecting Breath Rate

and choosing anything

from four breaths per

minute to ten.

2 Pick a face
Breathe can be set 

as a Watch face 

complication. Firm 

press on the display 

when viewing a face 

and Customise. Tap a 

complication and use 

the Digital Crown to 

select Breathe.

5 Switch off 
the haptics
If you like looking at 

the screen during your 

breathing exercises 

and you don’t need the 

prompts of the haptic 

feedback, change it from 

Prominent to Minimal or 

turn it off.

3 Set a 
reminder
You can alter the 

Breathe app’s functions 

on your iPhone. In the 

Watch app, tap My 

Watch>Breathe. Select 

Breathe Reminders and 

choose from every hour 

to every seven hours.

6 Use 
Previous 
Duration
To save you from 

having to alter a 

session’s duration each 

time, you can set it 

once on your Watch and 

then keep Use Previous 

Duration turned on.

Check
the summaries

You can view a summary

of the day with the number

of minutes you have breathed

for and your average heart

rate. Turn Weekly Summary

on in the Watch app for a

seven-day round-up

every Monday.
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1 Speedier 
responses
Smart replies are now available 

within the message notification, 

so you can scroll down and 

select the reply you feel is most 

appropriate, vastly speeding up 

your response time.

3 Send a sticker
In iOS 10 you’re able to install

and use sticker packs, and

watchOS 3 enables you to use

any that you have recently

sent to someone. Simply tap

the Emoji icon and swipe left to

see them.

2 Full-screen 
effects
Dictate a message like “happy 

birthday” and full-screen 

effects including animated 

balloons will show on the 

recipient’s screen. This makes 

an impact while saving time.

4 Tapbacks
Do you want to provide

feedback to a message you

received? Double-tap a

message and a list of Tapbacks

such as hearts and question

marks will appear, ready for you

to select and send.

Given the small size of the Watch and the lack of 

a keyboard, responding to messages in the past 

has been surprisingly effort-free, but that’s not 

to say there hasn’t been room for improvement. 

With watchOS 3, replying to messages is now 

much quicker, building upon the host of smart 

pre-written responses and the ability to dictate 

messages to send as text or audio. All the 

components you need for your replies are now all in 

one place, along with some brand-new features. 

Respond to 
messages quicker
Everything you need to reply 

is now in one place

The new Scribble feature gets around the lack of a keyboard and lets 

you quickly write text messages on your wrist. It works in apps that 

allow replies, from Messages to Mail.

Turn handwritten 
scribbles into text
You can use your own handwriting to 
compose a message

“Replying to 
messages is now 

much quicker, 
building upon the 
host of smart pre-
written responses”

1 Tap 
Scribble
When you’re ready 

to start composing 

a message, tap the 

Scribble button. You can

now start drawing letters

on the screen. As you do

this, the characters will 

convert to text.

2 Space 
and delete
You can also use 

punctuation and 

special characters. 

To aid you in your 

writing, there is a space

button and a function 

to delete for those 

inevitable mistakes.

3 Predictive 
text
Turn the Digital Crown 

as you write your words 

and the Watch will make 

predictions. Scroll down 

the list and select the 

word you’re after. When 

your note is complete, 

tap Send.

39

screen when you see the Scribble button and select the language you want.



40

Explore your all-new 
Control Centre

The amount of settings within your iOS 10 device is staggering, 

and if you find yourself getting overawed by the choices, then the

all-new Control Centre feature could come in handy. This menu

offers access to the most commonly used settings and features

on your iOS 10 device, without having to go through numerous

menus. New users can utilise Control Centre to enable and

disable things like their Wi-Fi and Bluetooth connections, while

more advanced users will be able to toggle the new Night Shift

feature. The eagle-eyed among you will also find the playback

controls listed on the second Control Centre panel, perfect for

controlling your Apple Music or Spotify feed.

Access essential features and settings through the 

redesigned iOS 10 Control Centre

Difficulty 

Time needed

1 Open Control Centre
Instead of being an independent app, Control 

Centre is a feature that can be accessed from 

most screens. Scroll up from the bottom of 

your display to open the Control Centre menu.

2 Toggle basic options
At the top you’ll find listings for core settings, 

including Wi-Fi and Airplane Mode. You can 

also toggle the brightness of your display 

using the bar underneath.

3 Utilise Night Shift
One of the new inclusions in Control Centre 

is toggling your Night Shift routine on and off. 

Press on the tab provided to set up a new 

routine if needed.

Make use of the new Control Centre in iOS 10Step-by-step

10

iOS 10
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Control 
Centre settings

4 Connect with AirDrop
Above the icons for your torch and timer is the 

AirDrop menu. Be sure to enable this if you 

want your iOS 10 device to be discoverable to 

others when it comes to sharing files.

5 Control playback
Swipe left to open up the secondary panel. 

Apps like Apple Music and Spotify work with 

this panel and give you all the basic playback 

controls needed for your audio feed.

6 Discover Apple TV
You may also want to select the AirPlay 

Mirroring option that is provided. Your device 

will scan for your Apple TV, enabling you to 

AirPlay files across.

What can you really do in 
the iOS 10 Control Centre?

 Connect with AirPlay
If you’ve invested in an Apple TV, connecting 

it to your iOS 10 device couldn’t be easier. 

Use the AirPlay Mirroring option provided to 

establish a quick link between the two.

 Use Night Shift
This looks to alter your display’s colour levels 

to better prepare you for going to bed. Enable 

the feature here or create a new schedule.

 Manage basic functions
At the top of the Control Centre menu you’ll 

find options for many of your device’s core 

functions. Use the buttons provided to both 

enable and disable them when needed.

 Link with other apps
At the bottom of Control Centre you’ll find 

links to some of the most commonly used 

iOS features. Use these icons to open things 

like your rear camera and timer.

 Knowledge base

Remove from 
your lock screen
Considering the features that 

can be accessed through it, 

it’s advisable to remove the 

Control Centre from the lock 

screen in case your device 

falls into the wrong hands. 

Open Settings and select 

the Control Centre tab from 

within. From there you can 

disable the Access on Lock 

Screen option.

Want to stop your device from switching between landscape and portrait? 
Use the Orientation Lock option at the top right of the Control Centre.



Master your new 
Widgets panel

To many people, the term widgets means a block of information 

that resides in the home screen, as is the case on Android

devices. Apple, however, has continued to stay away from such a

notion in order to keep the home screen as clean as possible, but

that doesn’t mean that improvements haven’t been made. The

beefing up of the Widgets screen in iOS 10 makes them more

accessible and easier to read, thanks to a more pronounced

design and added features that app developers can leverage to

make them more interactive. The Widgets screen is no longer just

a list of information to read when in a hurry, and is now more akin

to real apps that can be accessed with one swipe.

Get to grips with the new and improved 

iOS 10 Widgets panel

Difficulty 

Time needed

1 Swipe to open 
If you swipe from the top of the home screen 

you will see all of your latest notifications. The 

two dots at the bottom highlight the fact that 

there are now two panels to navigate.

2 View your widgets 
Swipe right and the widgets will appear. The 

advantage here is that you can now see all 

of your new notifications and app widgets 

without technically leaving your home screen. 

3 Customise layout
Scroll to the bottom of the screen until you see 

the Edit icon. Tap it and you will be taken to a 

new screen where you can begin to add new 

widgets and make changes to the layout. 

Understand the new Widgets setupStep-by-step

10

iOS 10
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Instant 
updates that work

4 Add and remove widgets 
Tap a red circle to remove an app and then 

scroll down to see other widgets that you can 

add by tapping the ‘+’ icons. You can change 

the order by holding and sliding each widget. 

5 See real-time information
For apps that want to present real-time

updates, you will need to go to their settings

and enable Background App Refresh. This

greatly increases widget usability.

6 Touch to add
On 3D Touch enabled devices, you can simply

hold and press an icon to add widgets for

selected apps. Look for the small Add Widget

option when you use the 3D Touch action.

Great-looking widgets 
in a logical screen

Visual splendour
Apple has redesigned the appearance

of widgets so that they now take up their

own space and stand out against any

background. The result is modern and clean.

Just a glance
Many of the widgets that are designed to

offer real-time updates and info now display

data in a much more obvious way.

Customise the look
Some widgets let you expand them to reveal

extra entries of more detailed information.

You can select and expand the most

important ones for your requirements.

Edit the list
You can add new widgets and change the

order of them using the Edit icon at the

bottom. Take time to experiment with the

ones that work best for you.

 Knowledge base

Media-based widgets
What you see today is likely 

just the start of what will be 

available. Apple has already 

demonstrated a widget that 

includes video streaming, and 

potentially we will see many 

more uses for widgets within 

iOS. The fact that they can be 

used to retrieve information 

and provide entertainment 

without opening an app is a 

huge bonus. 

Widgets can be accessed by sliding from the top of the home screen or by 
sliding right on the lock screen. They are always close by.
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View notifications 
without pressing anything

Notifications are vital for any phone owner, but historically you 

have had to go through a number of steps to see what exactly

has come in. The situation has now completely changed, and

with a couple of very minor tweaks you can view new messages

by simply lifting up your phone. You will need to consider whether

you want previews of emails and messages to show on the lock

screen for security reasons, but if you do, you should be able

to instantly view new notifications and either act upon them or

simply put the phone back down. It’s all part of Apple’s gradual

improvement of the iPhone and is another example of how a very

simple feature can become a part of your life when used properly.

Lift up your phone and see what you’ve missed – no 

screen tapping or button pressing required

Difficulty 

Time needed

1 Raise to Wake 
Go to Settings>Display & Brightness and 

make sure that the Raise to Wake option is 

enabled. This allows the lock screen to wake 

when you physically raise your phone. 

2 Show Previews
For some apps you will need to go to 

Settings>Notifications>App and make sure 

that Show Previews is enabled. Otherwise you 

won’t be able to read the content. 

3 Instant notification access 
When notifications appear in the future, all you 

need to do is lift the phone and they will be 

displayed on the lock screen for you. You can 

swipe to get a deeper view. 

Check missed notifications instantlyStep-by-step

10

iOS 10
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Create an automated 

routine in Home

Smart home devices are growing in number and the good news 

is that many of them are compatible with Apple’s HomeKit. This 

means they can be controlled using iOS; in the past, getting all 

of those various devices talking to each other was a bit of a pain, 

as you had to use third-party apps. Not any more. Apple has 

created a built-in app that lets you add accessories, create rooms 

and produce various scenes.

Say, for example, that you wanted your lights to turn on, your 

thermostat to kick in and your locks to open when you arrive 

home. With the right gadgets and the creation of a scene, you 

can activate all of those processes at the touch of a button. Be 

warned, though – it’s not the most intuitive of apps and it takes a 

bit of getting used to, but it’s worth persevering with since it’s a 

good step towards an integrated connected home.

Get your connected devices talking to each other 

with the new iOS 10 Home app

Set up scenes in HomeStep-by-step

Difficulty 

wnload available

Time needed

30

1 Add a room 
To organise your connected 

home, start by creating different 

rooms. Tap Rooms and hit the 

top-left menu button before 

choosing Room Settings. Select 

Add Room on the next screen.

2 Create a profile
You can now fill in the profile for 

your room, selecting the name – 

for example, kitchen or bedroom 

– and adding a photograph. 

Selecting Take Photo will access 

the camera.

3 Choose a photo 
Once you’ve taken your photo or 

chosen one from your Camera 

Roll by selecting Choose From 

Existing, you will just need to 

select Set and it will form part of 

the profile.

“Apple has created 
a built-in app that 
lets you add 
accessories, create 
rooms and produce 
various scenes”

iOS 10
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7 Test it out 
Scroll to the bottom of the screen 

to see an option to test the scene. 

Press this and whatever you 

were intending to happen should 

activate. Keep adjusting to get it 

to your liking.

8 Refine and adjust
To make further adjustments, 

you will see options for adding 

and removing accessories to 

your scene. Now turn on Show in 

Favourites to add the scene onto 

the main page.

9 Press the scene 
Now when you activate the scene, 

the various accessories should 

do what you intended. You can 

set up as many scenes as you 

like to suit a multitude of different 

scenarios in your home.

4 Create an 
automated routine
Now you have saved your profile, 

you need to make a routine. 

Select your room by tapping the 

menu option in the top left. Now 

tap + and then Add Scene.

5 Select a scene
Scenes enable you to tailor your 

setup for a specific purpose. You 

can select one of the suggested 

scenes, or you can create one 

of your own by selecting Custom 

and naming it.

6 Get set up
Now choose Add Accessories.

Select the ones you want and

tap Done. Touch and hold an

accessory to adjust its settings

(with Philips Hue, adjust the bulb

brightness or deactivate them).

Before you can get started, you

need to ensure your devices are

connected with Home. Thankfully,

this is a very easy task to perform.

Get
connected

To select your scenes without going into the Home app, head to the Control 
Centre and scroll to the right. You can access nine devices and eight scenes.

1 Add an accessory
Adding HomeKit-enabled gear 

to your connected home is easy. 

Ensure they are turned on and tap 

the Home button before selecting 

Add Accessory.

2 Tap to select
The next page will eventually show 

you a list of accessories you can 

use, enabling you to select the ones 

you want. They will show up within 

the app ready for you to use. 
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iew traffic information 
n route in Maps

Out of all the apps that have been updated in iOS 10, Maps is 

arguably the one with the most new features for users to check

out. For avid drivers, the new traffic search function is remarkably

helpful. In practice, it can help drivers to pinpoint the areas of

their route that are currently experiencing traffic problems, or

even spot passages of a motorway that are currently completely

blocked up. What we like even more about this new traffic

direction system is that it stems from the first time you search

out a route. Maps will automatically give you a series of possible

routes, each displayed with the traffic you’ll potentially face and

the time it’ll take you to reach it.

Avoid traffic jams with ease thanks to Apple Maps’ 

new traffic-tracking feature

Difficulty 

Time needed

1 Set your location 
The first thing we need to do is find our 

desired location. Open up Apple Maps and 

use the search bar provided to find the 

location you’re looking to travel to.

2 Get directions 
Once your location has been found, scroll up 

from the bottom of your display to find the 

Directions option. Press on this and Maps will 

begin to calculate your route. 

3 Choose your route
Maps will give you an overview of the routes 

you can take. Each has its own timings based 

on the traffic on that route. Select one of 

them, and press the GO button to start. 

Avoid holdups using Apple MapsStep-by-step

10

iOS 10
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Plan the 
perfect route

4 View traffic
As you travel, you’ll come across areas of 

traffic. Orange listings in Maps show minor 

traffic holdups, while red passages indicate 

roadworks and serious accidents. 

5 Zoom in and out
To take a closer look at the exact location of 

the traffic holdup, place two fingers on your 

display and move them apart to zoom in. Push 

them together to then zoom out. 

6 Switch routes 
If you’re hitting a lot of traffic, swipe up from 

the bottom of the Maps display and select the 

Overview option. Here you’ll be able to switch 

to a different calculated Maps route. 

View route details with ease 
and steer clear of traffic

 View congestion
When Maps generates your route, you’ll 

instantly be able to see the state of the 

traffic. Orange indicates minor holdups, while 

red indicates more serious traffic jams. 

 Faster route?
Maps will present different routes based on 

the traffic it finds within it. Press an alternate 

route to get directions from that instead.

 Take a closer look 
If you want to know the location of the 

traffic buildup, use two fingers to zoom in. 

In certain cases, you’ll be able to see the 

direction and lanes the buildup is situated.

 Switch and change
If you hit a patch of unexpected traffic, you 

can head back to this overview screen to 

switch to a different route. It might just help 

you avoid other buildups down the line. 

 Knowledge base

Avoid tolls
As well as providing you 

with information on traffic 

buildups and how to best 

avoid them, Apple Maps can 

also generate your routes to 

avoid all toll roads. Before 

confirming your route, 

keep an eye out for the £/$ 

symbol, as this helpfully 

indicates if the route 

contains a toll road that you 

need to pay for. 



50

Top 10 
3D Touch 
shortcuts

3D Touch in the iPhone 6s was undoubtedly a cool feature, and it 

certainly proved popular with users. However, in iOS 9 it always felt 

like the new technology was a little under-utilised. There were a few 

stock apps that used it, yes, but it was mostly a neat trick rather 

than a proper reason to upgrade.

That has changed entirely with iOS 10. The new system adds 

new 3D Touch controls for built-in apps, but also expands the 

feature to include things like Control Centre and notifications. 

What’s more, Apple has also opened up 3D Touch to third-party 

app developers, so in the coming months you’ll see more and more 

apps using the new abilities to expand the usefulness of their apps 

on the latest devices. Suddenly, 3D Touch has come into its own.

The latest time-saving 3D Touch 

techniques and controls for your 

iPhone and iPad

How’s the weather?
To quickly check the current weather, it’s now 

a simple case of using a 3D Touch to access 

the information. Hard press on the icon and 

you’ll get an instant forecast for where you are 

at that exact moment. Tap the Weather widget 

and the full app will open.

Flashlight control
Users with a 3D Touch screen can now 

get finer control over the flashlight in 

Control Centre. Use a hard press to open 

this menu, which enables you to choose 

between three brightness levels. Your 

selection will be saved as the default 

when you next tap the button.

Calendar 
events

You can use 3D Touch 

to check on your next 

Calendar event using 

the Up Next widget 

that appears when you 

press hard on the icon. 

Alternatively, you can 

quickly add a new event 

to your calendar, which 

will take you into the full 

app with a new event 

screen loaded.

Check your Activity
Get updates on your daily activity with 3D Touch

 The Activity widget
A hard press on the Activity app 

now brings up its widget, detailing 

your daily achievements. It will also 

let you jump straight to your history, 

workouts, and sharing options.

 Back in time
If you want to see 

how you’ve been 

performing recently, 

tap the History 

button. You can 

alternatively start a 

new Workout using 

the Workouts button.

 Health goals
This widget gives 

you a quick update 

on your daily activity 

goals, including the 

number of calories 

burned and the 

amount of exercise 

you’ve done.

 Sharing
You can finally share 

your Activity progress 

from within iOS 10 – 

before, you would have 

to take a screenshot to 

show others. Now just 

tap these buttons and 

share away.

iOS 10
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You can customise the sensitivity of 3D Touch in Settings>General> 

Camera modes
Control Centre has offered quick access 

to the iPhone camera for a while now, but 

finally it’s getting more options thanks 

to 3D Touch. Press hard on the icon and 

you’ll get options for recording videos, 

taking a selfie, recording slo-mo and 

taking a normal photo.

Apple Music
You can use a 3D Touch on a song or 

album to bring up several options. Add 

the track to your library or to a specific 

playlist, or alternatively share the track 

with friends. You can also choose to Love 

or Dislike a track here, to help Apple 

Music learn your preferences.

Quick replies
When you get an 

iMessage, or another 

text-based notification, 

you can 3D Touch the 

notification on the lock 

screen to quickly bring 

up a chat window and 

reply to the text instantly. 

It’s perfect when you 

just need to send a quick 

reply without unlocking 

your iPhone.

Control 
downloads
If you have a few 

different app updates 

downloading at the 

same time, use a hard 

press to bring up 

some options. You can 

prioritise an app you 

really want installed first, 

cancel an install or share 

the app with friends. 

You can also pause the 

download if you wish.

Add a widget
3D Touch presses on 

several stock icons now 

open the app’s widget, 

as well as a menu full of 

options. If you 3D Touch 

an app that doesn’t 

currently have a widget 

activated, you can tap this 

small Add Widget button to 

include it in your list.

Rename folders
Admittedly this one will 

only save you a few seconds 

here and there, but if you 

use a 3D Touch on a folder 

full of apps, you’ll get an 

option to rename the folder. 

This jumps straight into the 

folder and you can start 

typing, or you can delete 

apps with a tap.

Clear notifications
If you have a fair amount 

of notifications built up in 

Notification Centre, it’s now 

easier than ever to clear them 

all in one go. Simply use a 

3D Touch press on the Clear 

button and a Clear All option 

will appear, which allows you 

to clear every notification with 

a single tap. 



Set up and use 
the Bedtime alarm

There are a lot of people out there who struggle to get a good 

amount of sleep every night. While sleep trackers could be of 

use, Apple has included a new feature that looks to help you 

improve your sleeping pattern without the need for costly apps 

or uncomfortable wearables. Known as Bedtime, Apple’s new 

system uses a range of inputted stats to help give you the exact 

timings of when you need to go to sleep each night. You’re then 

given a personalised alarm, which should help you get out of bed 

each morning when it sounds. 

The main aim is to get you into a set routine, whereby you’re 

achieving a healthy amount of rest each night, but it does 

require prolonged use to work. With the addition of Health app 

integration, you can even track your sleep history and see where 

your sleep can improve.

Make sure you get the perfect night’s sleep with 

the new Bedtime feature in iOS 10

Set up a healthy sleep routine with BedtimeStep-by-step

Difficulty 

Download available

Time needed

20

1 Find Bedtime
This feature doesn’t have its 

own app in iOS 10. In fact, it’s 

embedded within the Clock app. 

Open up the app on your device 

and select the Bedtime icon at 

the bottom. 

2 Get Started
You’ll now be given a basic 

outline of what Bedtime is and 

what it can help you with. When 

you’re ready to begin, press on 

the Get Started button near the 

bottom of the display.

3 When to wake?
The first question you’ll be asked 

is when you want to wake up. 

Use the two sets of dials to scroll 

through to the exact time you 

want to wake up. When done, 

press on the Next option.

“Improve your
sleeping pattern
without the need
for costly apps
or uncomfortable
wearables”

iOS 10
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7 Enable Bedtime
Now that your Bedtime alarm 

has been set up, you’ll be taken 

to the overview screen. At the top 

you can find the option to toggle 

the Bedtime option on and off 

when needed. 

8 Change it up
If you want to make adjustments 

to your routine, drag your finger 

along the yellow bar to change 

the times. As you move it, the 

Bedtime and Wake listings above 

will change.

9 Take a closer look 
Head into the Options menu 

listed within the Bedtime feature. 

Here you’ll be able to alter the 

days your alarm goes off, as well 

as select when you want to be 

reminded of your Bedtime alarm.

4 Set a schedule 
You now need to select the days 

that you want your Bedtime alarm 

to go off. Press on each day 

listed within, or alternatively use 

the Every Day option to highlight 

them all. 

5 How much sleep? 
On the next screen, you’ll need 

to select how many hours of 

sleep you’d like to get each night. 

Use the scroll function to select 

an amount before pressing the 

Next option.

6 Sleep History
Bedtime will now give you an

overview of how the Sleep History

function works. To enable this

feature, head across to the Health

app once you’ve finished setting

up Bedtime.

If the default alarm won’t cut it,

you can personalise your Bedtime

experience with the help of one of

many alarm sounds.

Personalise
your Bedtime

Use the Bedtime Reminder option to set when you want to be prompted about 
your upcoming schedule. Give yourself enough time to get ready for bed!

1 Open Options tab
With the Bedtime menu opened 

and your current routine enabled, 

press the Options tab at the top 

right of the display. From here, 

select the Wake-Up Sound option. 

2 Choose your sound 
Scroll through the list of available 

sounds and press on one to 

confirm it. Alternatively, you can use 

the Vibration option listed to use a 

frequent vibrate motion instead.
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Customise threaded 

conversations in Mail

Threading has been a feature of Mail for a while, but iOS 10 takes 

it to a more usable level, enabling you to better see the flow of

a conversation. Instead of forcing you to move back and forth

between each email message by pressing Next and Previous,

you are now able to view each message within the one thread on

a single page. Each email appears in its own easily identifiable

block, and you simply have to scroll up and down. This makes

the threading feature far cleaner than before, while allowing you

to better keep on top of your messages. What’s more, you can

also customise the look of the threads, which will ensure it works

well for you. Here we will show you how to do just that.

With the new Mail features in iOS 10, it’s easier 

han ever before to keep track of your emails

Difficulty 

Time needed

1 Head to Settings 
To customise the threads, you need to visit 

Settings>Mail>Threading. If you want to view 

a complete thread in a single threaded view, 

ensure the Complete Threads option is on.

2 Organise by Thread
This option has been available for a while. It 

enables you to see multiple messages from 

the same thread as a single inbox entry, so if 

this is what you’d want, activate it.

3 View recent mail
You can select to have the most recent 

message on the top to save a lot of scrolling. 

It’s also worth noting that messages in a 

thread will be pulled from multiple mailboxes.

Use Mail’s new threading settingsStep-by-step

2

iOS 10
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macOS Sierra

Get started with Siri on Mac 
Siri is as useful on a Mac as it is on an iPhone

Siri has almost taken on a status similar to Hoover and iPhone 

in its ability to be recognised by name even if another service is 

used. It is capable, fast and for many iPhone and iPad users has 

slowly crept into their daily workflows to the point that using a 

mobile device just wouldn’t feel the same without it. The really 

good news is that Siri now works in almost exactly the same 

way on a Mac thanks to macOS Sierra, and it even comes with 

some extra functionality to boot. The wide-ranging nature of 

the implementation is impressive and so is the set-up process, 

which is almost non-existent, so it shouldn’t take you long to start 

enjoying Siri on your Mac, just as you do on your iPhone today.

Difficulty 

Download available

Time needed

10

Do almost anything with Siri 
The personal assistant now lives on your Mac

 Siri settings 
There are some settings for you to 

play around with to help you change 

the style of the voice and to set up 

Siri keyboard shortcuts. There is 

nothing unnecessary included in the 

settings screen.

 Manage apps 

Some Siri questions will open an 

associated app to give you the 

answer you need in greater detail. 

For example, asking for a route 

will immediately open the macOS 

Maps app. 

 Pin the answers 
You can click the ‘+’ icon in 

a Siri answer to pin it to the 

notifications panel. This lets you 

get the info you need and then 

refer to it when the time is right. 

 Knowledge base

Change 
system settings
Siri on a Mac is extremely 

flexible and has the ability 

to directly interact with the 

hardware itself. For example, 

you can say “Turn Bluetooth 

off” and it will be done 

immediately with a small 

panel appearing. This lets 

you turn it back on if needed 

and means that most of the 

hard-to-find settings are 

now easily accessible.

 Siri hasn’t aged 
The main Siri interface looks very similar to 

what you will be used to on your iPhone or 

iPad. It offers visual and audible feedback to 

help you understand the results instantly.
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1 Enable Siri
When you upgrade to macOS Sierra, you will 

be offered the opportunity to enable Siri. If you 

don’t, you can do so in Settings. There will 

also be dock and status bar icons. 

2 Set it up 
Head over to Settings>Siri where you can 

change the voice and language, choose the 

mic input and also set up a new keyboard 

shortcut for Siri. The settings are minimal.

3 Ask a question 
You can now use a keyboard shortcut or click 

the status bar icon to activate Siri. Simply ask 

a question and the answer will be spoken 

aloud and also visually displayed. 

4 Save the answer 
Tap the ‘+’ icon when an answer is previewed 

using an app pane in the Siri screen and it will 

be added to the Notification Centre. It’s simple 

and quick to refer to later.

5 Access more detail 
Some answers will come with a preview image 

and text so that you don’t need to move away 

from Siri to see everything you need. You can 

then click to view even more detail.

6 Set keyboard shortcut
Go to Settings>Siri and make sure you set up 

a fairly simple keyboard shortcut to activate 

Siri. This is needed to use ‘Hey Siri’ but is also 

handy at other times. 

7 Use dictation 
Go to Settings>Keyboard and click the 

Dictation tab. Enable it and then tick Use 

Enhanced Dictation. This enables the Mac to 

listen for any new vocal commands. 

8 Say Hey 
Now go to Accessibility>Dictation and tick 

‘Enable the dictation keyword phrase’. 

Type ‘Hey’ in the box and the Mac will start 

dictation when you say “Hey” in future.

9 The final setup
Click Dictation Commands and then the ‘+’ 

icon. Type ‘Siri’ in the top box, choose Any 

Application and then add the Siri keyboard 

shortcut. ‘Hey Siri’ now works. 

Use Siri on your MacStep-by-step

Siri can be enabled during the macOS Sierra set-up process or in System 
Preferences. We would advise you to try it because it works extremely well.
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There is no doubt that Apple products are becoming closer to

each other as time passes and Apple is gradually introducing

new features that will make you more productive if you have

bought into the ecosystem. Universal Clipboard is so obvious that

it’s surprising it is only becoming available now, and even more

surprisingly you will never actually see it when it is being used.

The entire process is as simple as copying text or an image on

one device and then using the paste command on another. The

data will be available on the second device in short order and

you can then paste it as if you had copied it on the same device

a second before. It will save you time on a daily basis.

1 Copy an image 
A good place to start is by copying a photo 

from an iPhone or iPad as you would do 

normally. You will not actually see anything 

different happen when copying text or images.

2 Find the paste command 
You can now open any app that supports the 

photo file format you copied and look for the 

paste command. It should be active to show 

that something is in the clipboard. 

3 The move is complete 
When you click the paste option, the photo 

you copied in Step 1 should immediately 

appear on your Mac ready for you to edit or 

add to a document. It only takes seconds.

4 Send it back 
You can edit an image and then send it back 

to your iOS device to be shared with others 

or edited in another app. You get to use the 

device that works best for the task. 

5 Be patient 
For larger files such as video clips, you will 

need to be patient and wait for the paste 

command to become fully active. They can 

take time to move between devices. 

6 There are limitations 
You can currently only copy and paste text, 

images and videos using Universal Clipboard 

due to the limitations of the iOS file system. 

The options may increase in the future. 

Copy and paste anywhereStep-by-step

Copy and paste between devices
With Universal Clipboard you can copy and paste between all your iCloud-enabled devices

Difficulty 

Download available

Time needed

10

macOS Sierra
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To use Universal Clipboard you will need an iPhone 5 or newer and a 
late 2009 or later iMac or MacBook. Most devices are supported.

Universal Clipboard is invisible 
You can magically copy and paste to another device

 Paste text 
It’s likely that you will copy and paste 

text most of the time and Universal 

Clipboard is particularly useful for 

dealing with very long and secure 

passwords. It saves a huge amount 

of time.

 Deal with media 

Pasting photos is another 

often-used feature of Universal 

Clipboard. The full images will be 

sent through, but at times with a 

small delay if they are very large 

in size. 

 Enable connections 
Wi-Fi and Bluetooth are both 

required to share clips between 

your macOS and iOS devices. 

You also need to ensure that the 

two devices you are using are 

close to each other. 

 Knowledge base

A growing ecosystem 
Universal Clipboard joins a 

growing list of features that 

are making iOS and macOS 

devices work seamlessly 

together. Messages, Auto 

Unlock, Handoff, Instant 

Hotspot and others are also 

available, and the more you 

explore what they do the 

more you will get from your 

Apple investments. Your 

devices no longer work in 

isolation, but as part of one 

connected unit. 

 Connect your devices 
iCloud is the magic ingredient to ensure that 

all of your devices are connected properly. 

Without it, Universal Clipboard will not work 

properly, so you must make sure they all use 

the same account.

No new feature will work perfectly every time and it is

possible that you will experience glitches when you first

start using Universal Clipboard. With luck you will be

able to copy and paste between your devices without

any issues. Realistically, however, when Bluetooth and

Wi-Fi are involved, there is always the possibility that

performance issues will appear from time to time. 1 Sign out 
If you are struggling to paste text and images, try 

signing out of iCloud on all of your devices and 

then sign back in. This has been known to resolve 

problems for many different features and may 

work for you. 

2 Use one router 
Ensure that both of the devices you are 

using are connected to the same Wi-Fi router. 

It’s very easy for one to be connected elsewhere 

or for the connection to have changed to another 

trusted device. 

Troubleshooting 
Universal Clipboard 

“Ensure that both of the devices 
you are using are connected to 
the same Wi-Fi router”
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Use Optimised Storage to save space
Configure macOS to free up disk space when needed

The transition from mechanical disk drive to solid state disk (SSD)

has boosted the performance of Macs and they are amazingly

fast, but space is often limited. If you are struggling for disk space,

a new feature in macOS Sierra called Optimised Storage solves

the problem. It makes use of iCloud and files can be stored online

instead of on the Mac’s disk. If the disk is short of space then files

are moved online, but if there is lots of space they will stay on the

Mac. You no longer need to worry about disk space and macOS

handles everything. When you need a file, you just access it in the

usual way and macOS opens it whether it is on the disk or online.

Here’s how to set up Optimised Storage.

Difficulty

Download available

Time needed

10

Reduce clutter
Use Review Files to find and delete big files

 Explore iOS files
Documents is not the only place to 

find space-hogging files. Select iOS 

files and iPhone/iPad backups are 

listed. Delete any you don’t need.

 File options
Hover over a file and two buttons 

appear. The cross deletes the file 

and the magnifying glass opens 

a Finder window to show the 

location and let you preview it.

 Sort by size
Each column heading is clickable 

and they enable you to sort the 

files. Click the Size heading and 

you can then see the biggest files 

that offer the most savings.

 Knowledge base

Space savings
The most obvious question 

is: how much disk space 

will be saved by Optimised 

Storage? The answer is that 

it depends. If you have a 1TB 

disk that is only a quarter 

full then you won’t save any. 

Optimised Storage will not 

save space unless space is 

needed, and you’ll see the 

most benefit on small disks 

that are nearly full.

 Explore Documents
Click Review Files on the Recommendations 

screen or select Documents on the left to 

view the files that are taking up the most disk 

space. Could you live without any of them?

macOS Sierra



61

1 Enable iCloud
Go to the Apple menu>System Preferences> 

iCloud. Make sure you are signed in to iCloud 

and that all the iCloud options are ticked. You 

need more than the 5GB free space.

2 View available space
Go to the Apple menu>About This Mac. Select 

the Storage tab and let the mouse hover over 

the end to view purgeable files, which is the 

potential space you could save. Click Manage.

3 Manage your storage
Select Recommendations in the top-left 

corner to access all the options and tools for 

optimising storage. If you just installed macOS, 

it might take some time to display.

4 Optimise Photos
Click the top Optimize button and there is an 

option to store photos in your iCloud Photo 

Library. Click Optimize. Photos are stored 

online when necessary, saving space.

5 Clean up iTunes
Click the second Optimize button and then 

Optimize again. Watched movies and shows 

are then automatically deleted to free up 

space. You can always download them again.

6 Delete old Trash
Trash management on your Mac at last! Click 

Turn On next to Empty Trash Automatically 

and files deleted more than 30 days ago are 

removed from the Trash to save disk space.

Set up Optimised StorageStep-by-step

Don’t worry about deleting movies, TV shows and books. Any items 
purchased through iTunes can be downloaded again any time you need them.

There are even more ways to save space on the Mac’s

disk. Select each of the items on the left like iBooks,

Mail, GarageBand and anything else that appears here. It

depends on which apps you use and sometimes there are

options for storing files online and only downloading them

when you need them. Here we take a look at the options for

iBooks and Mail and where savings can be made. 1 Purge iBooks
Do you use iBooks to read ebooks on your Mac, 

iPhone or iPad? Copies of books stored on your 

Mac can be deleted (download them again if you 

need them). Select all the books, Ctrl+click and 

click Delete.

2 Optimise Mail storage
If you use Mail and get a lot of email messages 

that have attached files, you can save space by 

clicking ‘Download only recent attachments’. 

Click the Optimize button and attachments are 

downloaded only when needed.

More optimisation 
options in macOS

“There are options for storing 
files online and only downloading 
them when you need them”
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1 Turn on iCloud
Go to the Apple menu and click System

Preferences. Select the iCloud icon. You must

be signed in to iCloud and it must be enabled

on the right. Click iCloud Options.

2 Enable the folders
These are all the apps that use iCloud to

store data. Tick the box next to Desktop &

Documents Folders at the top. This enables

Finder to use iCloud to store files online.

3 Wait, wait, wait
The Desktop and Documents folders are

uploaded to iCloud, which could take all day

if there are a lot. View the progress in Finder –

click the icon next to iCloud Drive.

Access your desktop on any device

One of the great new features in macOS Sierra is the ability to 

access files on your Mac’s desktop or the Documents folder 

from any computer, iPhone or iPad. This is useful in many 

scenarios, such as when you are at work and need to access 

a file on your Mac at home, or if you are at home and need to 

access a work computer. When you are out of the home or office, 

you can still access your files by using your iPhone, and if you 

are sitting on the sofa with your iPad and need to view a file on 

your Mac, there’s no need to get up, as it’s right there in front of 

you. This is a very useful and convenient feature, but you do need 

plenty of space on iCloud.

How to access your Documents and Desktop folders on iPhone, iPad and other Macs

4 Sign in 
On any computer, Mac or PC, open a browser 

and go to icloud.com. Sign in and the home 

page has an iCloud Drive icon. Click it to view 

the folders and files it contains.

5 View your files 
Click the iCloud Drive icon, select the Desktop 

or Documents folders and you’ll see all your 

files from these folders. Simply click them to 

access them.

6 Access via iOS 
If you have an iPhone or an iPad and have 

upgraded to iOS 10, find the iCloud icon on 

the home screen and press it. Your Mac’s 

Desktop and Documents folders are there.

Store Desktop and Documents folders in iCloudStep-by-step

Difficulty 

Download available

Time needed

10

macOS Sierra
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iCloud is used as storage by many apps on the Mac, iPhone and iPad – it is 
used for device backups, and for Photos.

iCloud features
Use iCloud Desktop and Documents features

 New sidebar section
Finder’s sidebar has changed and 

there is now an iCloud section. In it is 

iCloud Drive, which shows all files on 

iCloud, and Desktop and Documents. 

Click them to view your files.

 iCloud from anywhere
From any computer with an 

internet connection you can open 

a browser window, go to icloud.

com and view your files. Here 

are the Desktop and Documents 

folders. Click them.

 iCloud activity
An animated icon appears to 

the right of iCloud Drive when it 

is uploading files. It shows the 

progress, but clicking it opens 

a separate window with a more 

useful progress bar.

 Knowledge base

How does it work?
iCloud Drive works a bit 

like Dropbox, Google Drive, 

OneDrive and other online 

drives. Your files are stored 

in your online storage and 

can be accessed only by 

you. If they are changed 

on your Mac, on another 

computer, iPhone or iPad, 

or if files are added, the 

changes are synced across 

all devices so you always 

see the latest files.

 Add extra columns
Right-click a heading and select Show 

iCloud Status. This adds an extra column in 

Finder that shows whether files are stored on 

the disk or on iCloud. It’s optional.

Apple provides 5GB of online storage space, but that

is shared with your Mac, iPad and iPhone. It is unlikely

that there will be sufficient space to store the Desktop

and Documents folders in the free space, so you will

almost certainly need to increase your storage with a

paid upgrade. Fortunately, it is very cheap and 50GB

(for £0.79/$0.99 a month) should be plenty for those two

folders. Select the Documents folder in Finder and press

Cmd+I to see its space requirement. 1 Buy more space
Click the iCloud icon in System Preferences and 

then select the Manage button at the bottom. 

Click Buy More Storage or Change Storage Plan 

to see your options. Choose a plan and follow the 

instructions to upgrade.

2 Check the space
To see how much space is being used on iCloud 

to store your Desktop and Documents folders, 

open iCloud in System Preferences and click 

Manage. Select Other Documents and the total 

usage is shown on the right.

Buy more space 

“You will almost certainly 
need to increase your 
storage with a paid upgrade”
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You can’t always control every element that appears in your

photographs. For example, you may not spot a distracting

object at the edge of the frame, and you can’t always wait for an

unwanted person to leave the location before you snap the shot.

Some events happen spontaneously, so you may only have time

to shoot first and worry about removing unwanted elements later.

Even if you meticulously compose your image you may not notice

artefacts such as sensor (or dust) spots until you view the photo

on a larger display. Fortunately, Photo’s powerful Retouch tool

can help remove sensor spots and ugly street furniture such as

lampposts, creating a cleaner-looking picture in a few clicks.

Difficulty

Download available

Time needed

10

1 Import asset 
Chose File>Import. Browse to our supplied 

start image – Retouch_start.jpg. Click Review 

for Import. Double-click to view the photo. It 

suffers from a range of unwanted elements.

2 Choose Aspect 
Click Edit. There’s no point cloning out edge 

objects with the Retouch tool when you can 

remove them more quickly. Click the Crop 

icon. Set Aspect to Original Landscape.

3 Crop the edges 
Drag the top-right corner handle to crop out 

the shop’s signage. Drag the bottom-left 

handle to crop out the foreground rock. Rotate 

the crop overlay to straighten the tilted horizon.

4 Retouch sensor spot 
Click the Crop icon to apply the changes. 

Click the Retouch tool and zoom in to see the 

remaining sensor spot. Increase Size to cover 

it and click to replace with a patch of cloud.

5 Erase simple objects 
The Retouch tool analyses the area adjacent 

to the sensor spot and chooses appropriate 

pixels to heal over it. You can replace a duck 

with clear water using this technique.

6 Remove complex objects 
To lose complex objects such as people, 

Alt+click to manually sample a suitable area 

next to the unwanted subject. Then, spray the 

sampled area over the people to hide them.

Remove unwanted and distracting elementsStep-by-step

Master the Retouch tool in Photos
Tidy up a photo by removing blemishes, artefacts and distracting objects 

Photos
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Eliminate unwanted clutter
Create a more attractive-looking shot 

7 Tidy the edit 
This complex clone operation won’t always 

work first time. Here we then need to sample 

part of the lower ramp and clone that over the 

area the couple were standing on. 

8 Remove street furniture 
Alt+click the mountain next to the lamppost, 

then move the cursor over the area where 

the mountain needs to extend over the post. 

Spray the post to replace with suitable pixels.

9 Finishing touches 
Once you get the hang of sampling and 

cloning pixels with the Retouch tool, you can 

get rid of almost anything. Here we’ve removed 

another lamppost for a cleaner composition. 

 Cloning
For more complex retouching, hold 

down Alt to sample a specific detail, 

such as this fence. You can then spray 

the cloned area in the cross-hairs over 

unwanted objects in the brush stroke 

(such as these people).

 Retouch tool
Click here to summon the 

Retouch tool. Use the adjacent 

Size slider to increase this brush-

based tool’s tip so that it’s big 

enough to remove a sensor spot 

in a click.

 Become a cropper
There’s no point in removing 

sensor spots with the Retouch 

tool if you’re going to crop them 

out when improving composition, 

so always start with a crop. This 

will remove distracting elements 

at the edge of the frame without 

you needing to clone them out.

 Knowledge base

Aspect
The term Aspect refers to 

the photo’s aspect ratio – 

it’s shape and orientation. 

It’s important to crop using 

the shot’s original aspect 

ratio or you’ll change its 

shape. This will make it 

look different to other non-

cropped images from the 

same shoot. If you need the 

edited image to fit into a 

specific picture frame then 

you can use common aspect 

ratios such as 5:7.

 Healing
If you click on a sensor spot the Retouch tool 

will grab an adjacent section of clear sky and 

place it into the brush tip. It then combines 

the transplanted pixels with their neighbours 

to create a seamless blend.

When using the Retouch tool you can quickly adjust the brush tip’s size using 
the ‘[’ and ‘]’ bracket keys. This helps you cover small or large artefacts.
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Thanks to social media outlets such as YouTube and Facebook,

it’s a simple matter to share your iMovie productions with family,

friends or followers. However, it may be more of a challenge to

keep them glued to the screen if your show doesn’t feature the

animated titles and captions that they’re used to watching in

professionally produced programmes. Fortunately, it’s a simple

matter to add animated graphics, titles and captions courtesy

of iMovie’s Theme Chooser. We’ll show you how to quickly add

themes to already edited timelines so you can enhance old

programmes and give them a new lease of life, but you can also

experiment with different themes during the editing process too.

Difficulty

Download available

Time needed

10

iMovie

Instantly enhance movies with themes
Improve your iMovie productions with professional captions and graphics

Use iMovie’s Theme Chooser
Add titles and transitions with ease

 Themed assets
When you select a theme for your 

project using the Theme Chooser, a 

new collection of themed titles and 

captions will appear in the top section 

of the Titles browser. 

 Drag and drop
As you add a clip to the timeline, an 

opening and closing themed caption 

will automatically be added to the first 

and last clips. Dissolve transitions will 

appear between each clip too. 

 Change a theme
The Settings section in the 

timeline enables you to quickly 

change the current theme and 

replace its opening and closing 

titles by clicking this button. This 

launches the Theme Chooser.

 Knowledge base

Add themes to 
old programmes 
You may have a collection 

of old edited projects that 

lack the extra bells and 

whistles of iMovie’s themed 

assets. Luckily you can 

add them with ease. Open 

an old project and go to 

Window>Theme Chooser. 

Click to choose a new theme 

and click Change. New 

themed opening and closing 

titles will automatically be 

added to your project.

 Automatic content
By default a theme automatically adds titles 

and transitions when you drag clips to the 

timeline. You can disable this function by 

unticking this box. You can then manually 

drag assets from the Current Theme section 

of the Titles browser into the timeline.
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1 Start from scratch
Click Projects and then click the Create New 

icon. Choose Movie. You can click Import 

Media to add movie files, or select an existing 

event of imported clips.

2 View Titles 
Choose Window>Content Library>Titles. This 

is packed full of animated captions and titles. 

You can reveal even more titles by choosing a 

theme for your project.

3 Open Theme Chooser 
Go to Window>Theme Chooser (or press 

Cmd+6). Click on a theme’s play icon to 

preview its unique titles and transitions. Click 

to choose a theme, then click Change.

4 Preview theme assets
Click back on the Titles browser. You’ll now 

see new themed captions and titles in the 

Current Theme section. Most contain a title for 

the beginning, middle and end of your movie.

5 Add clips
Click on My Media. Drag clips from an Event 

into the timeline to start creating your movie. 

The chosen theme’s opening and closing titles 

will appear above the first and last clips.

6 Edit the text
The opening caption will feature the name of 

your project while the closing caption will say 

‘Edited by’ and include your name. Double-

click on a theme’s purple bar to edit the text.

7 Add more titles
A dissolve transition will be placed between 

each clip as it is added to the timeline. Go 

back to the Titles browser and drag other titles 

onto clips in the middle of your programme. 

8 Adjust Settings
After editing you may decide that you’d prefer 

using a different theme. To change the existing 

theme, click on the Settings icon at the top 

right of the timeline. Click the Theme button.

9 Quick change 
The Themes window will reappear. Preview 

a few and chose one to apply. Click Change. 

The previous theme’s opening and closing 

titles will be replaced by the new theme.

Add themed assets to your showsStep-by-step

If you decide that you don’t want to use themed titles, go to the Theme 
Chooser and click No Theme. The themed titles will vanish from the timeline. 
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Priding itself on being easy to use, GarageBand makes getting

sound in and out of the application straightforward in virtually

every respect. Inputting live instruments for recording is as simple

as when it eventually comes to exporting your songs for sharing.

Importantly though, GarageBand is best known for its use of

loops and using snippets of pre-recorded audio within a project.

A large library of Apple Loops, in audio and MIDI forms, can be

dragged and dropped to quickly layer tracks together. The good

news is that this same principle can be used to ‘import’ external,

non-Library audio and MIDI files too. Formats including AIFF, CAF,

WAV, AAC, Apple Lossless and MP3 are all supported.

Difficulty

Time needed

20

1 Open project 
As always with GarageBand, things generally 

start with an open project. Whether new and 

empty, or with tracks already added, make 

sure you are ready to start importing. 

2 Select files from Finder 
Audio ranging from AIFF to MP3 can be 

imported straight out of Finder or from the OS 

X desktop. First identify and select the audio 

file you wish to add to the project.  

3 Drag onto track 
You can now simply drag the audio file into 

GarageBand’s Tracks area. It can be dropped 

directly into an existing audio track (blue) if 

present within the project.

4 Place into new track 
Alternatively, you can drag the file into the 

empty area below any existing tracks. The 

imported audio will automatically be added 

into a new track with default settings.

5 Migrate some MIDI  
The same technique applies to any existing 

MIDI files you wish to add. However these 

must be dragged and dropped into any 

existing software instrument track (green). 

6 Import tempo info 
Added MIDI files will likely have tempo 

information encoded, so GarageBand prompts 

you to Import Tempo or reject it as desired. 

Upon selection the file is added.

Add audio and MIDI files to a projectStep-by-step

Import audio and MIDI files
Expand on your selection of Library loops by importing audio and MIDI regions

GarageBand
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Areas for adding audio
Picking out the parts that matter most when it comes to importing files 

7 Show Media Browser 
Another method for importing audio, or even 

movies, is with GarageBand’s own Media 

Browser. Show this by clicking the button in 

the very top-right corner of the control bar.

8 Browse and preview 
The Media Browser lets you browse for audio 

and songs within the GarageBand folder or 

your iTunes library. Files can then be selected 

and previewed with the play button.

9 Drag into project 
As before, your chosen file or files from the 

Media Browser can simply be dragged from 

the file window and dropped into the Tracks 

area to be imported into the project.

 Target track type
Audio files can be imported into 

existing real audio tracks (those 

coloured blue). MIDI files however 

must reside within the green software 

instrument tracks. New tracks of the 

correct type are added automatically if 

neither already exists.  

 Drag and drop 
The simplest way to import audio 

or MIDI files into a project is to 

literally drag them into the Tracks 

area. They can be dropped into 

an existing matching track type or 

below to add a new one. 

 Media Browser 
Show the Media Browser from 

the View>Show Media Browser 

menu or with the F key shortcut. 

From this panel you can search 

for Audio or Movie files, preview 

them and drag them into the 

Tracks area. 

 Knowledge base

What is a MIDI file?
GarageBand enables you 

to import a range of audio, 

including MIDI files. These 

differ from your typical AIFF, 

WAV or MP3s because they 

don’t contain any recorded 

sound. Instead they package 

data interpreted by digital 

instruments rather than a 

waveform, which is why they 

appear differently within the 

green software instrument 

tracks and can have 

individual notes edited.  

 The Tracks area 
This is the main project workspace within 

GarageBand, where all audio or MIDI regions 

reside within corresponding tracks. External 

files can be dragged and dropped directly 

into this space from Finder or the desktop.  

stored in /Library/Audio/Apple Loops/Apple, and organised in folders.  
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Logic Pro X

Mix your tracks using Logic’s Mixer
In this issue’s mixing tutorial, we look at how to use mix automation

In the last of our three-part tutorial series on using Logic’s mixer, 

we’re going to focus on the mix automation system. This allows 

the recording of moves such as fader adjustments, channel mutes 

and changes to plug-in parameters and effect sends, so that 

they’re remembered and played back by the computer. Logic’s 

mix automation system has four main operating modes – Write, in 

which all moves are overwritten, Read, in which moves are played 

back, Touch, in which moves can be ‘overdubbed’ at any point 

and Latch, in which moves are recorded but the new parameter 

value replaces existing automation after the control is released. To 

follow the steps, download the LPX Mixer Pt3 project from FileSilo.

Difficulty 

Download available

Time needed

30

Advanced automation tricks
Automation turns a static mix into an evolving sonic landscape

 Read all about it
Once you’ve finished making all the 

moves you want to a track, set the 

mode back to Read. The automation 

mode selector changes to a solid 

background when automation data is 

present on that track.

 Power play
Automation can be enabled or 

disabled via the power buttons 

that appear next to the mode 

indicators when you mouse 

over them.

 On or off
If a track’s automation mode 

indicator is white, it means 

automation is disengaged for that 

track. If automation is enabled, 

the text will be green.

 Knowledge base

Ahead of the curve
By pressing the A key while 

in Tracks view, you can 

view the automation data as 

curves plotted on special 

automation lanes allocated 

to each track. This is where 

you can zoom in and fine-

tune your moves by adding, 

deleting and moving control 

points. Most parameters of 

most instruments and effect 

plug-ins that work with Logic 

can be automated this way.

 Write away
Use Write mode with caution, since it records 

new control moves yet erases existing 

automation on the track as the playhead 

passes over it. Touch is the mode to use to 

add new moves to existing data. 
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1 Write mode
With the LPX Mixer Pt3 project loaded, set the 

guitar track’s automation mode to Write by 

selecting it from the pop-up menu. Ignore any 

warning dialogues for now.

2 Get set
Disengage Cycle mode so that the track is no 

longer looping. Park the song pointer at the 

start of bar 1 and pull the guitar fader down to 

its lowest position.

3 Fade up
As the track plays, slowly raise the fader back 

up to its initial level of -6dB over the first four 

bars, allowing it to reach this level with about 

four bars left to go.

4 Touchdown 
Hit stop. The mode defaults to Touch to allow 

you to make adjustments. If you don’t want to 

make any, set the mode to Read. Otherwise, 

we’ll leave it in Touch mode for now.

5 A little quieter
Hit play and the fader moves up, reproducing 

your moves. We don’t want it to be as loud in 

the mix though, so grab it as it reaches -7dB 

and hold it there until the track ends.

6 Latch on
Now switch the track to Latch mode. As the 

tune plays from the top again, sweep the 

track’s pan control from +25 to -25. It’ll stay 

put once you let go, as it’s in Latch mode.

7 Make an intro
Park the track at the top, then mute the Drums 

and Tambourine tracks. These are grouped, 

so mute both by clicking the M button on just 

one of them. Set the automation to Latch.

8 Bring the beat back
Play the track and unmute the channels after 

two bars to bring the drums and tambourine 

back in. Hit stop and switch to Read mode. 

This has created a two-bar instrumental intro.

9 Fade out
A common use for automation is to perform 

a fade at the end of the song. Set the Master 

channel’s automation mode to Latch and pull 

it down over the last four bars to fade out.

Automate your mixes with LogicStep-by-step

If you have a hardware controller with physical rotary knobs and faders, 
these make recording automation data even more of a natural process.
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Final Cut Pro X

When filming with a camcorder or DSLR it can be a challenge

to capture a correctly exposed image, especially if you’re

shooting in high-contrast lighting. The camera may automatically

close the aperture to capture detail in a bright sky, resulting

in underexposed shadows (as you’ll see in our project’s

downloadable clip). Fortunately, Final Cut Pro X allows you to

diagnose and fix exposure-related problems with help from a

histogram. This graph shows the spread and strength of the

shadows, midtones and highlights in your clips. We’ll illustrate

how to combine the histogram display with selective tone-

tweaking tools to create more correctly exposed clips.

1 Import example clip 
Choose File>New>Event. Label the Event 

‘Exposure Fix’. Tick the Create New Project 

box and click OK. Choose File>Import Media. 

Import our ‘underexposed.mov’ example clip. 

2 Play the clip 
Drag the clip into the timeline. To the naked 

eye it looks underexposed, especially in the 

shadows. For a more precise understanding, 

we need to analyse its spread of tones.

3 Summon the histogram 
Go to Window>Viewer Display>Show Video 

Scopes. A new panel will appear. Click the 

gear icon and choose Histogram from the 

Scope section. Tick Luma in Channels.

4 Analyse the greyscale tones 
Darkest shadows should have a value of 0. 

Brightest highlights should have a value of 

100. Here the Luma histogram shows that the 

weak highlights peter out at 75. 

5 Make global adjustment
Choose Window>Go To>Color Board. Click 

the Exposure icon. Drag the Global slider up 

to 10%. The entire histogram graph slides right 

towards the brighter end.

6 Selective tone adjustments 
The clip looks washed out, so drag the 

Shadows slider down -10% for darker 

shadows. Drag the Highlights slider up to 25%. 

The highlights now reach the far right at 100. 

Tweak tones with help from histogramsStep-by-step

Fix exposure problems using histograms
Create consistently correct exposures with help from the handy histogram display

Difficulty 

Download available

Time needed

20
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Shoot your footage on a Neutral or Faithful camera setting. This creates a 

7 Correctly exposed 

at both the far left and the far right. This is 

8 Boost midtones 9 RGB view
Set the gear icon to RGB Overlay. You can 

Helpful histogram 

 0 to 100
Our clip’s histogram was cluttered 

towards 0 at the left, indicating that 

it was underexposed. Here we’ve 

re-mapped the weaker highlights to 

stronger levels of 100 to create a clip 

with a healthier spread of contrasting 

shadows, midtones and highlights.

 Before and after
Click here to go to the Inspector. 

By toggling the blue square 

adjacent to the Color Board’s 

channel, you can turn it on and 

off in order to compare the 

edited clip with the original 

unedited version.

 Exposure adjustments
This panel enables you to 

selectively darken shadows and 

lighten midtones and highlights. 

The accompanying histogram 

graph helps you tweak individual 

tones to ensure a correct 

exposure while avoiding clipping.

 Knowledge base

Before you shoot
It’s much better to capture 

a correct exposure than it 

is to fix problems in Final 

Cut. This is because you 

might reveal compression 

artefacts when you brighten 

up underexposed shadows. 

Some cameras can summon 

a histogram on their LCD 

display, so manually adjust 

the camera’s exposure 

settings to ensure a 

healthy spread of shadows, 

midtones and highlights.

 Luma histogram
You can summon a range of histogram 

displays in the Scope window. The Luma 

option displays the tones in the clip as an 

undulating greyscale graph. A clip’s shadows 

appear at the left of the histogram, midtones 

in the middle and highlights at the right.
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Genius Bar
Our Apple devices and the software on them are some of the finest computing 
products on the planet, but even they have their moments. That’s where we 
come in; to give you expert advice and get you back up and running in no time

After upgrading to macOS Sierra my Wi-Fi either doesn’t work or is
incredibly slow. Any tips? Patty McFarland

Glossary
The place to come for 

key technical terms made 

easy to understand 

Spudger

An important tool in any 

Apple Genius’ arsenal! 

Black plastic spudgers 

are used to pry and poke 

all manner of devices.

Router

A router is a networking 

device that forwards 

data packets between 

computer networks. It 

performs traffic directing 

functions on the internet.

Time Capsule

Apple’s own wireless 

backup hardware, 

available to purchase from 

any Apple Store. 

M9 Processor

Part of the A9 processor 

in newer iPhones, used 

for detecting motion and 

controlling “Hey Siri”.

SATA

A common connection 

type found within 

computers, mainly used 

with storage devices.

SSD

Solid State Drive. A light, 

fast and quiet disk-less 

storage drive found in 

newer Macs.

Having Wi-Fi problems is a common 
upgrade issue that takes time to fix

Facebook
iCreateMagazine

Twitter
@iCreateMagazine

Web
icreatemagazine.com

Email
icreate@imagine-publishing.co.uk

1 Head to Finder
Turn off Wi-Fi and close all your 

apps. Open Finder>Go and 

navigate to the ‘Go to folder’. 

Type /Library/Preferences/

SystemConfiguration/ and hit Go.

2 Select files
Locate and select the following: 

com.apple.airport.preferences.

plist, com.apple.wifi.message-

tracer.plist, NetworkInterfaces.

plist and preferences.plist.

3 Delete and reboot
Drag these files to the Trash 

can. Reboot your Mac and Wi-Fi 

router. When your Mac has 

rebooted, turn Wi-Fi back on and 

things should be back to normal. 
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1 Get latest iTunes
Sounds like you’re not using the

latest iTunes, so you need to

manually update. Go to apple.

com/iTunes and click Download.

2 Download Now
The latest iTunes version is

available over on the left. Click

Download Now and iTunes will

begin to download as normal.

3 Install software
Unpackage the iTunes DMG

installer and follow the installation

instructions carefully. Hit Continue

and then Install Software.

I own a Razer mouse, but it won’t work with 

macOS Sierra! What can I do to fix it? 

Lois Cavanaugh

This is a known problem with Razer and Logitech 

peripherals. Our guess is by the time you read this, 

both companies will have released software update 

drivers to fix the problem, but in the meantime, 

there is a quick workaround. Unplug your mouse, 

then delete the RazerHID.kext file found in /Library/

Extensions/RazerHID.kext. Now restart your Mac 

(go to Apple>Restart), plug in your mouse and 

everything should be working properly.

What’s happened to iTunes? It won’t work! I’ve upgraded to Sierra and now 
I can’t use Apple Music at all on my Mac. Help. Craig Bennett

Everything is running slower on my Mac after installing the new macOS. 
Why is this happening? Should I buy a new Mac? Mary Halstall

When you upgrade to a new operating system, you need to update your 
apps separately. Many developers will push new versions for macOS Sierra.

 Activity Monitor
Your Mac has a built-in 

app that lets you see 

what type of health your 

machine is in, as well 

as giving you analysis 

on what is causing any 

macOS Sierra speed 

issues you might have.

 See Memory hoggers
Click on the Memory tab at the top to see 

all the apps and services currently using 

your Mac’s RAM. The biggest hoggers will 

be listed at the top, giving you an idea of 

what is slowing down your Mac.

 Close an app
You can close an app down directly 

from Activity Monitor. If an app if using 

an alarming amount of RAM in the 

background, click on the app and then head 

to the X icon in the top left.

 CPU levels
The CPU tab gives you real-

time results, and will help you 

to identify apps and processes 

that are slowing your Mac 

down. Force Quit those causing 

alarming spikes by selecting 

them and clicking the X icon.

The one-stop
column for 
Genius advice
I want to upgrade my 

Mac to macOS Sierra, 

but how do I found out 

if the machine I have is 

compatible or not?

The easiest way to check 

is to click on the Apple 

logo in the top-left corner 

of your desktop and then 

About This Mac. You’ll 

then see your Mac’s model 

name and year. If it’s 2010 

or later (or 2009 for a 

MacBook or iMac), then 

you’re all set.

If I upgrade my Mac to 

macOS Sierra, should I 

wipe my Mac and start 

afresh or simply back up 

and upgrade?

There’s really no right or 

wrong answer here — but 

everyone has an opinion! 

Unless you’re experiencing 

any particular difficulties 

right now, making a couple 

of backups and updating to 

macOS Sierra is a perfectly 

acceptable way to go.

I’m trying to download 

Sierra but I’m getting 

an “error has occurred” 

message all the time!

This is another common 

upgrade issue that leaves 

you needing to delete the 

current macOS Sierra 

installer. Open Launchpad 

and you’ll see an 

incomplete ‘macOS Sierra’ 

file with a question mark 

on it. Delete this, reboot 

your Mac and start the 

installation directly from the 

Mac App Store again.

Some third-party peripherals 
need refreshing to start working
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Ever since I

upgraded to iOS 10

I’m having major problems

with my Wi-Fi and

Bluetooth connections.

Hasan Ali

This is a problem that

comes up with virtually

every major iOS update.

There’s no logical reason

for it to happen, but it is

very frustrating. The best

solution is to actually reset

your network settings,

wiping everything clean so

that it’ll work seamlessly

with iOS 10. Go to

Settings>General. Scroll

down to Reset and then tap

Reset Network Settings.

Enter your passcode when

prompted and that should

fix your connection issues.

Help! I’ve been using a

beta version of iOS 10

and now I can’t seem to get

the final version. What do I

need to do? Stephen Bagley

To get that final version of

iOS 10, you’ll need to plug

your iPhone into a Mac or

Windows machine, fire up

iTunes and put it into recovery

mode. To do this, press and

hold the Home button and

Sleep/Wake button and keep

holding while it restarts.

When you see the Apple

logo, hold on a little longer

until you see the Recovery

Mode screen. You’ll then

have the option to download

and install the latest version

of iOS 10. Make a note of this

in case you ever download a

beta again!

Resetting network 
settings will help 

wireless connections

I’m really struggling to free up space on my iPhone to update to iOS 10.
What’s the best way to make more room? Aimee Britton

Get an overview
To see where your iPhone

storage is being used, head to

Settings>General>Storage &

iCloud Usage and tap Manage

Storage under Storage.

See what’s free
The number next to Available

tells you how much storage

you have available. At least

three or four gigabytes is ideal

for updates.

In-app settings
Some apps, like Snapchat,

have in-app settings to clear

caches and reduce the space

they take up, so check the

worst offenders.

 Delete for now
iOS updates often free up 

space once installed, so you 

could always temporarily delete 

some apps and reinstall them at 

a later date.

Genius Bar

The one-stop
column for 
Genius advice
I used to be able to 

screenshot my Apple 

Watch. Why did Apple 

get rid of that ability?

Here’s some good news 

– you can still screenshot 

your Apple Watch by 

pressing the Digital Crown 

and Side button at the 

same time. You just need 

to enable the feature now 

in the Apple Watch app on 

your iPhone. Head to the 

General menu and then

Enable Screenshot. 

Is there any difference 

between updating my 

iPad to iOS 10 using 

iTunes or via Settings 

on the iPad itself?

There’s no huge 

difference, as both result 

in your iPad running iOS 

10. However, if you’re low 

on storage space on your 

iPad, you might have more 

luck updating via iTunes. 

This has worked well with 

updates in the past.

I’ve installed iOS 10 on 

my iPhone but can’t 

get the Raise to Wake 

feature working. Any 

ideas how to fix this?

Raise to Wake in iOS 

10 does come with a 

caveat in that it needs 

your iPhone to have an 

M9 processor to work. 

They’re fitted in all iPhones 

from the 6s onwards, so 

if you’ve got an iPhone 6 

or older, you might be out 

of luck. If it helps, we feel 

your pain on this!
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Be careful when deleting photos from Memories as it also means they are 
permanently deleted from your library and cannot be retrieved too easily.

The new Memories videos are great, but there’s photos 
I don’t like in them. How do I delete them? Fion Kearny

My battery is draining way quicker since I upgraded to iOS 10. 
I’ve heard I’ll need to wait for iOS 10.1 to fix this! Luca King

1 Brightness settings
There are some simple tips to follow 

before iOS 10.1 drops. Turn your display’s 

brightness down for a start.

2 Background refresh
To save loads of battery, go to Settings>

General>Background App Refresh and turn it 

off to stop apps beavering away unnoticed.

3 Fitness tracking
This is a great battery-saving tip, especially if 

you own an Apple Watch. In Settings>Privacy> 

Motion & Fitness, turn off Fitness Tracking.

I couldn’t wait to get my hands on iOS 10, but 

when I downloaded it onto my iPad, it bricked it! 

I’m so disappointed. Is there a way to recover my iPad 

– I’ve taken for granted how often I use it. Laura Taylor

This is very frustrating, and seems to have happened 

to some users who updated in the first hour. There is a 

fairly straightforward fix though. Connect your iPad to 

a Mac or Windows machine running the latest version 

of iTunes. When you’ve opened iTunes, hold down the 

Home and Sleep buttons on your iPad to enter Recovery 

Mode. iTunes should display a prompt to either Update or 

Restore your iPad. Click 

Update and patiently wait 

for your iPad to load up 

iOS 10. This is the best 

way to fix a bricked iOS 

device at any time

iOS 10 has bricked some 
devices but the fix is simple

I used to be able to rate a music track on my 

phone, and the rating would get downloaded to 

iTunes when I synced my phone to my MacBook. Now 

there’s only the heart button, but nothing else. How 

can I set the a 0 to 5 rating in iOS 10? William Ledley

Unfortunately, Apple has done away with ‘rating’ tracks 

in iOS 10, moving solely to ‘liking’ 

music through its heart symbol. 

There are third-party apps out 

there that can rate your tracks 

in the traditional way, but we 

couldn’t see any way that they 

would sync with your Mac. The 

only workaround we found is to 

use Siri. Ask Siri to rate a track, 

confirm the rating and your digital 

assistant will do the work for you.

Siri still gives you the option 
to rate tracks from 0-5

 Tap away
Tap once on any photos you’d rather 

weren’t included in your Photos 

Memories video. They’ll display a small 

blue tick next to them.

 Tap the trash
To delete your selected photos, tap the 

Trash can in the bottom-right corner 

and confirm that they will be deleted 

from your library.

 Show ‘em all
By default, Memories displays a 

selection of photos, but more appear in 

your video. To see them, tap Show All 

opposite the Photos heading.

 Make a selection
To select photos you want to delete, 

tap on the Select heading in the top-

right corner of the Photos interface (this 

becomes Cancel).



80

5 Three more screws
Remove the three Phillips screws (shown in red) 

securing the hard drive to your Mac. Be aware that 

it’s still hooked up by a cable, though!

6 Disconnect the cables
Finally, use your fingers (or a plastic spudger, if 

needed) to disconnect the SATA data and power 

cables connecting your hard drive to the iMac.

3 Not a fan
Before you can get to your hard drive, you’ll need 

to remove your iMac’s fan cover. Remove its 

Phillips screws and lift it out of position.

4 Unplug the sensor
Down the side of the hard drive is a small thermal 

sensor cable. Be sure to disconnect this before 

you remove the hard drive completely.

1 Lose the screws
Flip your iMac G5 on its front (screen down) and

loosen the three Phillips screws along the bottom.

These are captive, so they only loosen.

2 Lift that case
Slowly lift up the rear panel on the back of your 

iMac (pulling it slightly towards you as you do so) 

and set it carefully out of the way.

My white iMac doesn’t turn on. Can I retrieve 
the photos on my hard drive? Mikaela Hansen

Great news, Mikaela, it’s possible! We’re going to assume your white 

iMac is one of the iMac G5 models for now. To take it apart and retrieve 

your hard drive, all you really need is a screwdriver and a bit of time. 

A plastic spudger might help, too. You’ll also need to think about how 

you’ll get that old drive connected to your new Mac. The drive itself uses 

a SATA connection, and there are plenty of USB adapters available to 

buy for situations exactly like this. Be careful with that drive when you do 

remove it, as it’s easily broken if rattled or dropped. With those caveats 

out of the way, our friends at iFixit.com have helped us put together the 

guide below to help you retrieve that old hard drive with ease.

The one-stop
column for  
Genius advice
When I plug my 

MacBook’s charger in, 

it doesn’t light up, but it 

does still charge. What’s 

gone wrong?

First of all, check to see if a 

different charger does the 

same thing. If so, you may 

need to reset your Mac’s 

System Management 

Controller. This process 

varies from Mac to Mac 

and you’ll find instructions 

on Apple’s website.

I’m trying to remove a 

cracked screen from 

my iPhone but the 

shattered glass keeps 

peeling away. Any tips?

Before you remove a 

cracked screen, cover it 

in a large piece of sticky 

tape. That should keep 

the whole thing together 

and make it much easier 

to remove in one go. We’d 

also recommend using a 

suction cup, which tends 

to make it even easier.

I’ve had an iPhone 6 

for a while, but have 

just noticed that my 

FaceTime camera 

seems to have slipped 

down. What can I do?

This seems to be a 

problem that’s cropped 

up for a small number of 

iPhone 6 owners. Your 

best bet would be to take 

it your nearest Apple Store 

for advice. They may be 

able to offer a replacement 

to get that FaceTime 

camera set straight again.

Genius Bar
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Tools needed

Missing any of these?
You can order any
parts or tools you
might need from www.

ifixit.com/store.

Screwdriver

Screwdriver

If you would like more help with upgrading your Mac, visit the
gadget surgeons at iFixit.com, who kindly contributed these photos.

I’m looking at buying a second-hand 15-inch MacBook Pro (with the CD
drive), but it’s quite old now. Is it easy enough to upgrade? Samantha Rye

Replacing your MacBook’s disk drive with a hard drive will require a special 
enclosure. You can grab one from  if you’re heading down that route.

Replacing the battery

surprisingly easy to replace the battery. If 

hand machine, this may be your first port 

of call.

Giving your Mac a minor speed boost can be 

easily achieved by upgrading its RAM. Head 

to crucial.com and use their tool to find out the 

and install.

Go solid state

a little more involved, but still easy enough 

to do without professional help. Replacing it 

performance and speed.

Still use CDs?

the side of your Mac for a while, you 

could actually replace this drive with an 

up for the challenge.

 Clean the fans

a lot of use.

It might be old, Samantha, but luckily the unibody MacBook Pros contain a lot of user-upgradeable parts. 

Your only real limiting factor here is the processor, as that’s soldered onto your Mac’s logic board. If that’s 

good enough, though, you’ve got the opportunity to make some serious performance gains elsewhere with 

your Mac’s internals. For a huge speed boost, you could consider upgrading its hard drive to an SSD (and 

replace the CD drive with a second SSD, if you wanted). For a quick and cheap upgrade, updating your Mac 

with more RAM is easy and fairly economical. It really all depends on the money you want to spend. To help 

you out, our friends at iFixit have taken apart the 15-inch MacBook Pro to show you what’s inside.
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Best iPhone 7 cases

Group test

iPhone 7 Silicone Case
£35/$35

www.apple.com

As far as fit and comfort goes, there is nothing 

better than an official case from Apple. 

They come in a range of natural colours to 

perfectly complement your iPhone, while the 

soft microfibre lining on the inside gives great 

protection against scratches and the like. 

The silicone back feels great in the hand, but 

we’ve previously experienced little chips and 

marks appearing on the case’s ridges too 

frequently for our liking, and we expect the 

same to happen here.

X-Doria Revel
£19.99/$29.99

xdorialife.com

Perfect for someone looking to add a bit 

of personality to their iPhone protection, 

X-Doria’s Revel range comes in 12 quirky, eye-

catching patterns, including fox, pug, lion and 

polar bear. It’s not all about the design though, 

with each case featuring a slightly raised 

bezel to protect against drops and surface 

scratches. Your iPhone 7 fits snugly, the hard 

outer shell is surprisingly light, impact resistant 

and you have easy access to all your ports 

and buttons.

Just Mobile TENC
€24.95/$24.95

www.just-mobile.eu

We completely understand those who 

can’t bring themselves to put a case on 

their iPhones. To some degree it defeats 

the object of buying something that looks 

so good, but Just Mobile’s clever solution is 

a crystal-clear case that discreetly clips to 

the back of your iPhone 7 and adds very 

little bulk or weight. You see your iPhone 

in all its glory, and Just Mobile’s brilliant 

self-healing technology repairs any marks 

and keeps your case – and iPhone – 

looking pristine.
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X-Doria Defense Lux
£29.99/$49.99

xdorialife.com

X-Doria’s second entry into this test takes 

protection to another level. Able to protect 

your iPhone 7 against drops onto concrete 

from two metres (that exceeds military drop 

test standards, by the way), the Defense Lux is 

made from an impact-resistant polycarbonate 

backing and machined with an aluminium 

outer frame. A soft inner rubber layer wraps 

your phone safe, and X-Doria’s soft leather 

rear panel does an admirable job at making 

the Lux look luxurious too. One tough cookie.

Gear4 D30 The Carnaby
£34.99/$49.99

www.gear4.com

Gear4 has done a fine job at making a tough 

and rugged case look appealing. The Carnaby 

comes in three iPhone colours – silver, gold 

and rose gold – and features a perforated 

back mesh panel that subtly reveals the true 

colour of your iPhone. It’s a unique method, 

and one we quite enjoyed. Toughness is the 

real selling point here though thanks to the 

D30 impact technology, which is the same 

material found in American football helmets 

and combat uniforms. Sturdy.

Cygnett UrbanWallet 
Flip Case 
£29.95/$49.95

www.cygnett.com

The UrbanWallet from Cygnett is effectively 

two cases in one. On the surface it’s a flip 

case that holds two credit cards, but a clever 

magnetic design means the inner case is 

detachable. The magnet does add some bulk 

and weight, but the genuine black softened 

leather and metallic outer rim looks great. 

Being able to carry cards with you is an 

obvious benefit, as is slimming things down 

and using it with a car mount.  
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Reviews

Placing your speakers in the optimum position,

in order to hear your music from anywhere in the

room, is something that anyone hosting a party

has had to face. Should you wish to broadcast the

music to more than one room, it’s near impossible

to find somewhere to place the speaker without it

being really loud in one place, and quiet in another.

The Gear4 Black Stream speakers (Stream 1

and 3) are designed to play the same music across

different places, but they can come in useful for so

much more than extending the sound at a party.

They can act as affordable surround sound in large

spaces, and the fact that they rely on their own

router means that you can take them anywhere

without requiring the internet. The Gear4 Stream 1

is compact and light enough to take anywhere with

you, and while the speaker has a 3.5mm cable to

plug in with, the Stream app is also there to help

you connect, along with Bluetooth setup.

In terms of the sound that the Stream 1 offers, 

it’s surprisingly good quality for the size of the unit, 

with a strong bass and a fairly clear sound. Given 

that one of the biggest qualities of this range is 

that they’re great to work with outside, the sound 

doesn’t travel particularly well in the open air – but 

inside they’re exemplarily.

The Stream 1 also offers a lot more than you’d 

expect from your average speaker; while there are 

speakers of superior sound quality available on the 

market – some priced considerably higher – no 

other speakers offer Gear4’s patented Pair/Share 

feature, which enables you to add more speakers 

to your set. Add in the charge-out feature that lets 

you charge your phone when you’re playing music, 

and the Gear4’s speakers are extremely good value 

for money. They’re ideal for having on in the house 

or taking away on holiday, and they’re remarkably 

affordable for the sound quality.

The Stream 1 is portable, powerful and extremely easy to set up.

Pair with the Stream 3 speaker and you’ll create a very decent multi-room setup. 

Gear4 Black Stream 1
£99/$130

Verdict

The Stream speakers have handles on

the top to help transport them, making

them perfect for taking out and about

Control the speakers using buttons on

the top of the machine, which are clear

and can’t be accidentally knocked

The built-in router enables you to take 

them wherever you like, whether you’re 

within Wi-Fi range or not

Key features Learn more
gear4.com

Available from
gear4.com
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Key features

Reviews

A good pair of stylish, comfortable headphones, but on the expensive side of the scale. 

For those serious about audio quality it’s best to look for a better pair.

Moshi Avanti

Verdict

The vegan leather earcups are super 

soft and sit comfortably on the ears; 

they come in brown or burgundy red

Playing and pausing with the cable’s 

middle button is expected, but you can 

pick up and decline calls on the go too

Made out of stainless steel, the 

headband also has sliders to enable 

quick folding away and adjustments
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Key features

Learn more

The Kitsound Unity offers a surprisingly good alternative to big-brand soundbars with cinematic sound. 

However, for all the space (and money) it will save you, there is still room for improvement.

Kitsound Unity

Verdict

The tempered glass top doesn’t just 

look good, it allows the soundbase to 

withstand TVs up to 50kg

The Unity has coaxial, optical and the 

typical 3.5mm auxiliary inputs, as well 

as Bluetooth connectivity

In addition to having a remote, the 

Unity has touch controls to adjust the 

volume, source and power
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Reviews

Lava BrightSounds 2
£39.99/$49.99

www.lavaaccessories.co.uk

Enjoyed some camping this summer and already planning 

some cool accessories to take with you next year? Lava’s 

BrightSounds portable Bluetooth speaker should feature 

highly in your thinking, simply by virtue of providing you 

with three services – it’s a speaker, ambient night-time LED 

light and a built-in power bank all wrapped in a cute, easy-

to-carry and water-resistant design. The battery lasts for 

36 hours of music playback and 48 hours of light function. 

The 5W speaker is easily loud enough and you won’t 

find any distortion here. And all for an impulse-buying 

price? Sign us up now.

Twelve South SurfacePad
£69.99/$79.99

www.twelvesouth.com

Twelve South’s SurfacePad is an innovative option when it 

comes to protecting your 9.7-inch iPad Pro. It sticks to the 

back of your iPad with an adhesive (don’t worry, it leaves 

no residue if you want to take it off) instead of clipping on 

like a traditional case. Its biggest strength is how little bulk 

it adds to your iPad – the edges are on show, but then so 

are all the important connection options. The SurfacePad 

wrap is made from high-quality leather and comes in 

natural tan and black colours, will wake/sleep your iPad 

and has a built-in, multi-angle viewing stand.

Accessories
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Moshi IonBank 3K
£55/$64.95

www.moshi.com

Portable power banks aren’t renowned 

for being a particularly good-looking 

accessory, so we were mightily 

impressed by Moshi’s super-stylish 

IonBank. It looks like a small coin purse, but the soft vegan 

leather cover opens to reveal built-in Lightning and USB 

cables. Our test unit had a 3,200mAh capacity battery 

(you can get 5K and 10K versions for additional cost) and 

that gives your iPhone 120 per cent more battery. Moshi’s 

SmartSense circuitry magic enables you to charge your 

device and the IonBank at the same time. Very impressive.

Audio-Technica ATH-SR5BT 
£149/$199

www.johnlewis.com

Now is probably a good time to invest in 

some Bluetooth headphones. As you’ve 

probably heard, Apple has ditched the 

3.5mm headphone port. Audio- 

Technica’s ATH-SR5BTs feature a delightful, sleek black 

and chrome design, and extremely high comfort levels 

thanks to their lightweight padded cushions and minimal 

clamping force. Sound took a while to warm up, and the 

bass isn’t threatening, but the overall soundscape is 

outstanding. On the downside, there is no noise cancelling, 

and you need to add a wire to get true Hi-Res audio 

compatibility. We can live with that, though.

Verbatim iStore ‘n’ Go 
USB Drive 16GB

£24.99/$34.45

www.amazon.com

Apple has got rid of the paltry 16GB storage option 

from its new iPhone, but even the base 32GB versions 

can push you for space. A cheaper solution than buying 

a more expensive iPhone would be to invest in one of 

these smart USB and Lightning flash drives. They instantly 

boost your iPhone’s storage by either 16, 32 or 64GB, and 

make it easy to quickly transfer content between your Mac 

and iPhone. You need to download Verbatim’s iStore ‘n’ Go 

app to transfer stuff, but it’s a freebie from 

the App Store and works effortlessly. 
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One of the drawbacks of switching from PC to Mac

is that some of the software you previously used

in Windows will no longer be available. Parallels

Desktop is the solution and it runs Windows on your

desktop. It can even integrate it so well that it looks

like Windows apps are running in OS X/macOS.

Parallels Desktop enables you to download

and run versions of Windows from XP to 10 with

a couple of mouse clicks. It also supports other

operating systems and Chromium, Android and

popular Linux distros can be run just as easily. One

of the benefits of this twelfth edition is support

for the latest versions of these operating systems,

including Windows 10 and macOS. You can even

install OS X/macOS in a virtual machine.

There have been a bunch of speed improvements,

such as faster snapshot creation and suspension of

virtual machines, shared folders and performance

when the Mac is low on memory. It seems less of

a struggle to run on a 4GB Mac, although 8GB is 

recommended. Battery life is 10 per cent better, 

and this is partly due to suspending Windows 

maintenance tasks when using OS X. Different 

resolutions can be set when using external displays.

Acronis True Image backup with 500GB of online 

storage is also included. Instead of saving a copy 

of a virtual machine and using gigabytes of disk 

space, an incremental backup online uses none. 

Both enable you to return to a previous virtual 

machine state. Another addition is the Parallels 

Toolbox, a collection of tools that enable you to 

record audio, download and convert videos, capture 

screenshots, set alarms and timers, archive and 

extract files and more.

Acronis backup and Parallels Toolbox are not 

core to the app and may not be a necessity, but 

there are certainly enough other features to make 

Parallels Desktop 12 a great buy.

There are lots of changes to this edition and perhaps more than previous updates,

making it an attractive upgrade (half price) or outright purchase.

Parallels Desktop 12
£64.99/$79.99

Verdict

Virtual machines
The range of options for creating

virtual machines running guest

operating systems is excellent

Parallels Toolbox
This optional extra provides a

collection of tools for performing

a variety of additional tasks

Acronis True Image
If you don’t have a backup, one-

year’s access to Acronis True Image

online and local backup is included

3 Key Features

“Download and 
run versions of 
Windows from 
XP to 10 with 
a couple of 

mouse clicks”

Requirements Learn more
parallels.com

Available from
parallels.com
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Every photographer working with people will

know that image retouching is an art form, a skill 

that takes years to perfect. The extensive list 

of techniques such as skin smoothing, warping 

selections and creative manipulation of adjustment 

layers, as well as the understanding of the human 

form in both posed and differently lit conditions, is 

the kind of knowledge that plays a massive hand in 

how the end result will look.

So, is a quick-fix studio for body form 

manipulations and skin adjustments like the 

PortraitPro Body suite an effective tool, or obvious 

cheat? Of course there will be many who stick with 

Photoshop techniques, but for the ease of use, 

speed and range of manipulation, the PortraitPro 

Body suite could yield many benefits for any portrait 

photographer on a tight deadline. 

For the main part, you will spend most of your 

time plotting points on your subject’s frame, pointing 

out where shoulders meet elbows and elbows 

meet wrists, allowing the software to build up an 

understanding of the subject’s gender, structure, 

pose, length and whereabouts of appendages. 

Once plotted, adjust the areas using simple slider 

operations; you can alter the pose, shoulder height, 

waist and bust through limited adjustment.

Sensitivity with this tool is huge; as body 

representation is a hot topic within the photographic 

community, knowing how far is too far with body 

shape alterations is the difference between 

offending your client or complimenting them. It’s 

not about changing someone, but accentuating or 

reducing elements for a more realistic result. Limiting 

the effect generated by some of the options via the 

slider commands will help you avoid cartoonish and 

over-exaggerated results.

Shape tools mean you can ‘liquefy’ rogue layovers 

from the initial body marker points and plotted facial 

markers. All of these features enable you to get a 

little more detailed in your adjustments, meaning 

there is more than enough to give your images a 

decent makeover. 

A great, well-priced tool that in the right hands will flatter, 

but it treads the line between gimmick and studio photographer must-have.

PortraitPro Body
£29.95/$39.95 (launch price)

Verdict

Connect the bones
Build a structure of your subject by

plotting points such as arm and hip

joints for later adjustments

Keep it real
Use the Shape tools to keep things

realistic – or not. These tools have

liquefying properties after all

Smooth out imperfections
Use masking techniques to plot out 

the areas that will need adjusting, 

such as skin and hair

3 Key Features

Requirements
OS X 10.7 or later

Learn more
portraitprobody.com

Available from
portraitprobody.com

“Alter the 
pose, shoulder 
height, waist 

and bust 
through limited 

adjustment”
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Everyone loses files at some point and backups can

certainly help in recovering them, but USB disks, 

thumb drives and memory cards aren’t backed up. 

Even files on the Mac’s disk can be created and 

accidentally deleted in between Time Machine’s 

hourly backups. A file recovery utility is therefore a 

useful tool and Tenorshare Any Data Recovery for 

Mac (ADRM) is one option.

It supports almost every version of OS X in 

use and almost any type of media formatted with 

HFS+ (Mac), NTFS (Windows), and FAT16/32 (USB 

storage). Lost Files Recovery is a quick way to find 

deleted files. After selecting a disk, it is scanned and 

a file list is built. You can browse the deleted files 

and preview certain types, such as images, and files 

can be selected and then recovered to another disk.

Raw Recovery is a more thorough type of scan 

that finds more files by looking at the raw disk data. 

For example, a USB thumb drive was formatted, 

changing it from a Windows filing system to Mac, 

and everything was wiped, but ADRM was able to 

locate most files and recover them. It took a long 

time and the filenames weren’t always right, but the 

files that were recovered were fine.

The app is also able to browse iPhone and iPad 

backups. If you regularly sync your devices with 

iTunes and back them up to the Mac’s disk, 

ADRM can open a backup and show the contacts, 

notes, reminders, Calendar events, text messages, 

photos and so on. This enables you to recover 

items that have been deleted on the device, but 

are in the backup.

ADRM isn’t quite perfect and the interface 

could be better – the window cannot be resized 

for example. A one-year licence for a single Mac 

looks expensive, but a one-off fee of £79.84/$79.95 

buys a Family Pack for up to five Macs, and this is 

the better deal.

The interface could be better, but this is an effective file recovery utility for the 

Mac that worked well in our tests.

Tenorshare 
Any Data Recovery

£125/$159.95 (Family Pack)

Verdict

Requirements Learn more
tenorshare.com

Available from
tenorshare.com

Scan and recover
The disk is scanned and a list of

deleted files is built. They can be

selected and recovered

iPhone/iPad recovery
Browse iPhone and iPad backups

created by iTunes, open them and

then recover any items you’ve lost

Save and resume
The results of a scan for deleted 

files can be saved so you can 

reload and continue later

3 Key Features

“The app is 
also able to 

browse 
iPhone and 

iPad backups”
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Final Cut Pro X is a powerful video-

editing app, but when it comes to 

grading a clip’s colours and tones its 

Color Board tools fall short. For greater 

control over adjusting a clip’s colour and tone, you 

need to add Color Finale to the mix. 

Color Finale is a grading app that plugs 

seamlessly into Final Cut Pro X’s workspace. It 

unleashes a powerful selection of extra tools that 

will take your colour grading to a new level. You can 

drag Color Finale from the Effects browser onto a 

clip in the timeline and use the Video inspector to 

launch the floating Color Finale panel.

This panel gives you access to four key tools. The 

Color Wheels tool lets you tweak the hue of the Red, 

Green and Blue channels that combine to create 

the colours in your clip. Adjacent sliders enable 

you to adjust brightness and contrast and boost 

saturation. Color Wheels do a similar job to the tools 

in Final Cut Pro’s Color Board, but as everything is 

accessible from the same panel it speeds up your 

grading workflow. 

One of Color Finale’s biggest guns is the Curves 

tool. Here you can manipulate points on a curve to 

lighten or darken specific tones with much more 

control than you’d get using the native Color Board. 

You can also selectively adjust the individual curves 

for the Red, Green and Blue channels to creatively 

alter colour as well as tone.

The LUT Utility lets you add Lookup Tables to 

the mix. These one-click presets enable you to 

change the colour and tone of a clip in an instant, 

so they act as an effective springboard towards a 

wide range of looks. The 6 Vectors tool enables 

you to target specific colours and adjust their hue, 

saturation and luminosity. You can toggle any of 

these four-layered tools on or off and reduce their 

individual opacities to fine-tune your look.

Color Finale’s versatile and powerful grading tools blend seamlessly 

into the Final Cut Pro workspace, greatly increasing its post-production grading powers.

Color Finale
£75/$99

Verdict

Requirements

Learn more
colorgradingcentral.com

Available from
colorgradingcentral.com

One click look
You can preview and apply Look Up

Tables (LUTs) in a click to creatively

change colours and tones

Clever curves
Curves are one of the most powerful

ways to adjust colour and tone. They

help make Final Cut truly Pro!

Selective colours
The 6 Vectors tool helps you darken 

skies to make clouds stand out, or 

make a colour more prominent 

3 Key Features

“A powerful 
selection of 

extra tools that 
will take your 

colour grading 
to a new level”
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Way back in 2013, Swedish developer

Image & Form released SteamWorld Dig. 

An action-adventure platformer, the title 

introduced console and latterly Mac 

players to a quirky mix of steam-powered cowboy 

robots. Well, skip to 2016 and follow-up SteamWorld 

Heist promises an outing that cranks the cool factor 

even higher. This time our mechanised steampunks 

are cowboy pirates, in space. The once side-on 

platform-based gameplay has also switched into a 

turn-based tactical shooter. Taking control of lead 

‘cowbot’ Captain Piper, you enlist a ragtag crew of 

characters and deploy parties of varying abilities and 

weapon loadouts across story missions. These 

generally consist of loot-gathering quests initiated by 

guiding your team’s ship to new destinations within a 

sprawling interstellar map. As you progress and 

grow in experience the challenge grows more 

intense, revealing SteamWorld Heist to be an 

ingenious puzzler at heart. By mixing ranged

shooting and up-close melee attacks with the 

strategy of waiting your turn or finding effective 

cover, the game milks fairly simple mechanics. You 

can only move a certain distance and instigate 

certain attacks in a single go, forcing you to think 

carefully about how your bots engage waves of 

enemies. Thankfully though, SteamWorld Heist is so 

brilliantly realised that its addictiveness endures 

across 15 to 20 hours of gameplay. Grinding 

character stats, upgrading weapons and clearing 

new areas is compelling enough but excels here 

given the flawless presentation. Charming graphics 

and sounds are one thing, but the fantastic 

gamepad support with authentic button commands 

for PS4 and Xbox controllers is another. This 

robustness of design permeates throughout and 

transforms a strategic space shooter into an out-of- 

this-world adventure that rarely runs out of steam.          

SteamWorld Heist blends tactical turn-based combat with hugely addictive 

character development to deliver a stylish and highly recommended game for Mac.

SteamWorld Heist
£14.99/$19.99

Verdict

I’ll just hang here while you open 

that big door… guides show where 

you can move at every turn

Missions of varying challenges are 

scattered among the cosmos for 

your ship to unlock

The game amusingly makes a big 

thing of hats and invites characters 

to find and wear all kinds of styles

Levels are stocked with weapons, 

armour and even water – essential 

currency for steam-driven robots 

We used

Available from
Mac App Store

“Its 
addictiveness 

endures 
across 

15 to 20 hours 
of gameplay”
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